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C H A P T E R 5

Create Circuits and VT Tunnels

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to create Cisco ONS 15327 electrical circuits, VT tunnels, optical circuits, 
and Ethernet circuits. For additional information about ONS 15327 circuits, refer to the Circuits and 
Tunnels chapter in the Cisco ONS 15327 Reference Manual.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15327 Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-B127 Verify Network Turn Up, page 5-3—Complete this procedure before you create any 
circuits.

2. NTP-B181 Create an Automatically Routed DS-1 Circuit, page 5-5—Complete as needed.

3. NTP-B182 Create a Manually Routed DS-1 Circuit, page 5-10—Complete as needed.

4. NTP-B183 Create a Unidirectional DS-1 Circuit with Multiple Drops, page 5-13—Complete as 
needed.

5. NTP-B184 Create an Automatically Routed DS-3 Circuit, page 5-18—Complete as needed.

6. NTP-B185 Create a Manually Routed DS-3 Circuit, page 5-22—Complete as needed.

7. NTP-B186 Create a Unidirectional DS-3 Circuit with Multiple Drops, page 5-24—Complete as 
needed.

8. NTP-B133 Create an Automatically Routed VT Tunnel, page 5-30—Complete as needed.

9. NTP-B134 Create a Manually Routed VT Tunnel, page 5-32—Complete as needed.

10. NTP-B187 Create a VT Aggregation Point, page 5-35—Complete as needed.

11. NTP-B135 Test Electrical Circuits, page 5-37—Complete this procedure after you create an 
electrical circuit.
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12. NTP-B188 Create an Automatically Routed Optical Circuit, page 5-39—Complete as needed.

13. NTP-B189 Create a Manually Routed Optical Circuit, page 5-43—Complete as needed.

14. NTP-B190 Create a Unidirectional Optical Circuit with Multiple Drops, page 5-45—Complete as 
needed.

15. NTP-B62 Test Optical Circuits, page 5-51—Complete this procedure after you create an optical 
circuit.

16. NTP-B191 Create an E-Series EtherSwitch Circuit (Multicard or Single-Card Mode), page 
5-53—Complete as needed.

17. NTP-B192 Create a Circuit for an E-Series Card in Port-Mapped Mode, page 5-55—Complete as 
needed.

18. NTP-B142 Create an E-Series Shared Packet Ring Ethernet Circuit, page 5-57—Complete as 
needed.

19. NTP-B143 Create an E-Series Hub and Spoke Ethernet Configuration, page 5-60—Complete as 
needed.

20. NTP-B144 Create an E-Series Single-Card EtherSwitch Manual Cross-Connect, page 
5-62—Complete as needed.

21. NTP-B145 Create an E-Series Multicard EtherSwitch Manual Cross-Connect, page 
5-65—Complete as needed.

22. NTP-B146 Test E-Series Circuits, page 5-72—Complete this procedure after you create E-Series 
SONET circuits.

23. NTP-B147 Create a G-Series Circuit, page 5-73—Complete as needed.

24. NTP-B148 Create a Manual Cross-Connect for a G-Series or an E-Series in Port-Mapped Mode, 
page 5-75—Complete as needed.

25. NTP-B149 Test G-Series Circuits, page 5-78—Complete this procedure after you create G-Series 
SONET circuits.

Table 5-1 defines ONS 15327 circuit creation terms and options.

Table 5-1 ONS 15327 Circuit Options

Circuit Option Description

Source The circuit source is where the circuit enters the ONS 15327 network.

Destination The circuit destination is where the circuit exits an ONS 15327 network.

Automatic 
circuit routing

CTC routes the circuit automatically on the shortest available path based on routing 
parameters and bandwidth availability.

Manual circuit 
routing

Manual routing allows you to choose a specific path, not just the shortest path chosen 
by automatic routing. You can choose a specific STS or VT for each circuit segment 
and create circuits from work orders prepared by an operations support system (OSS) 
like the Telcordia TIRKS system.

VT tunnel VT tunnels allow VT1.5 circuits to pass through an ONS 15327 without utilizing 
cross-connect resources. VT circuits using VT tunnels will use cross-connect 
capacity only at the source and destination nodes. One VT tunnel can carry 28 VT1.5 
circuits.

VT 
Aggregation 
Point

VT aggregation points (VAPs) allow VT circuits to be aggregated into an STS to 
reduce VT matrix resource utilization. The STS grooming end of the VAP requires an 
OC-N card.
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ONS 15327 circuits are either VT or STS circuits. Table 5-2 shows the circuit source and destination 
options for VT circuits. 

Table 5-3 shows the options that display for STS circuits.

NTP-B127 Verify Network Turn Up

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at an ONS 15327 on the network where you 
will create circuits. If you are already logged in, continue with Step 2.

Step 2 From the View menu choose Go to Network View. Wait for all the nodes that are part of the network to 
appear on the network map. (Large networks may take several minutes to display all the nodes.) 

Table 5-2 CTC Circuit Source and Destination Options For VT Circuits

Card Ports STSs VTs DS1s DS3s

XTC-14 – – – 14 –

XTC-28-3 – – – 28 3

OC3 IR 4 1310 4 3 per port 28 per STS – –

OC12 IR 1310 

OC12 LR 1550

– 12 28 per STS – –

OC48 IR 1310 

OC48 LR 1550

– 48 28 per STS – –

Table 5-3 CTC Circuit Source and Destination Options for STS Circuits

Card Ports STSs DS1s DS3s

XTC-14 – – – –

XTC-28-3 4 – 1 3

OC3 IR 4 1310 1 3 per port – –

OC12 IR 1310 

OC12 LR 1550

1 12 – –

OC48 IR 1310 

OC48 LR 1550

– 48 – –

Purpose This procedure verifies that the ONS 15327 network is ready for circuit 
provisioning.

Tools/Equipment None

Prerequisite Procedures Chapter 4, “Turn Up Network”

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note If this is the first time your computer has connected to this ONS 15327 network, the node icons 
will be stacked on the left side of the graphic area, possibly out of view. Use the scroll bar below 
the network map to display the icons. To separate the icons press Ctrl and drag and drop the icon 
to the new location. Repeat until all the nodes are visible on the graphic area.

Step 3 Verify node accessibility. In the network view, all node icons must be either green, yellow, orange, or red.

If all network nodes do not appear after a few minutes, or if a node icon is gray with an IP address under 
it, do not continue. Look at the Net box in the lower right corner of the window. If it is gray, log in again, 
making sure not to check the Disable Network check box on the CTC Login dialog box. If problems 
persist, see Chapter 4, “Turn Up Network” to review the network turn-up procedure appropriate for your 
network topology, or refer to the Cisco ONS 15327 Troubleshooting Guide for troubleshooting 
procedures.

Step 4 Verify DCC connectivity. All nodes must be connected by green lines. If lines are missing or gray in 
color, do not continue. See Chapter 4, “Turn Up Network” and follow the network turn-up procedure 
appropriate for your network topology. Verify that all nodes have DCC connectivity before continuing.

Step 5 Investigate and resolve, if necessary, all critical (red node icon) or major (orange node icon) alarms. 
Click the Alarms tab to view alarm descriptions. Refer to the Cisco ONS 15327 Troubleshooting Guide 
to resolve alarms before continuing.

Step 6 From the View menu choose Go to Home View. Verify that the node is provisioned according to your 
site or engineering plan:

a. View the cards on the shelf map. Verify that the ONS 15327 cards appear in the specified slots.

b. Click the Provisioning > General tabs. Verify that the node name, contacts, date, time, and 
NTP/SNTP server IP address (if used) are correctly provisioned. If needed, make corrections using 
the“NTP-B81 Change Node Management Information” procedure on page 9-2.

c. Click the Network tab. Verify that the IP address, Subnet mask, Default Router, Prevent LCD IP 
Config, and Gateway Settings are correctly provisioned. If not, make corrections using the 
“NTP-B201 Change CTC Network Access” procedure on page 9-4.

d. Click the Protection tab. Verify that protection groups are created as specified in your site plan. If 
the protection groups are not created, complete the “NTP-B170 Create Optical Protection Groups” 
procedure on page 3-20.

e. If the node is in a BLSR, click the BLSR tab. (If the node is not in a BLSR, continue with Step f.) 
Verify that the following items are provisioned as specified in your site plan: 

– BLSR type (2-Fiber) 

– BLSR ring ID and node IDs

– Ring reversion time

– East and west card assignments 

If you need to make corrections, see the “NTP-B40 Provision BLSR Nodes” procedure on page 4-14 
for instructions.

f. Click the Security tab. Verify that the users and access levels are provisioned as specified. If not, 
see the “NTP-B30 Create Users and Assign Security” procedure on page 3-3 to correct the 
information.

g. If SNMP is used, click the SNMP tab and verify the trap and destination information. If the 
information is correct, see the “NTP-B87 Change SNMP Settings” procedure on page 9-23 to 
correct the information. 
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h. Click the SONET DCC tab. Verify that SDCC(s) were created to the applicable OC-N slots and 
ports. If DCCs were not created for the appropriate OC-N slots and ports, see Chapter 4, “Turn Up 
Network” and complete the turn-up procedure appropriate for your network topology.

i. Click the Timing tab. Verify that timing is provisioned as specified. If not, use the “NTP-B85 
Change Node Timing” procedure on page 9-15 to make the changes.

j. Click the Alarm Behavior tab. If you provisioned optional alarm profiles, verify that the alarms are 
provisioned as specified. If not, see the “NTP-B70 Create, Download, and Assign Alarm Severity 
Profiles” procedure on page 6-16 to change the information.

k. Verify that the network element defaults listed in the status area of the node view window is correct.

Step 7 Repeat Step 6 for each node in the network.

Step 8 As appropriate, complete the circuit creation procedure listed on page 5-1.

Stop. You have completed this procedure.

NTP-B181 Create an Automatically Routed DS-1 Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-1 on page 5-7), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters, 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 15327 network.

• Size—VT1.5 is the default. You cannot change it. 

• Bidirectional—Leave checked for this circuit.

• Number of circuits—Type the number of DS-1 circuits you want to create. The default is 1. If you 
are creating multiple circuits with the same slot and sequential port numbers, you can use 
Auto-ranged to create the circuits automatically. 

Purpose This procedure creates an automatically routed DS-1 circuit, meaning CTC 
chooses the circuit route based on the parameters you specify and on the 
software version.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
circuits field. Auto-ranging creates identical (same source and destination) sequential circuits 
automatically. Uncheck this check box if you do not want CTC to create sequential circuits 
automatically.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS will change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15327 Reference Manual for more information.

• Apply to drop ports—Check this check box you want to apply the state chosen in the State field to 
the circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports where the 
circuit state could not be applied. If the check box is unchecked, CTC will not change the state of 
the source and destination ports.

Note LOS alarms are generated if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed on protected drops only, that 
is, to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards and ports as source and destination choices.
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Figure 5-1 Setting Circuit Attributes For a DS-1 Circuit

Step 6 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27. Otherwise, continue with the next step.

Step 7 Click Next. 

Step 8 Complete the “DLP-B95 Provision a DS-1 Circuit Source and Destination” task on page 5-17.

Step 9 In the Circuit Routing Preferences area (Figure 5-2), click Route Automatically. Two options are 
available; choose either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box if you want to specify nodes and spans to 
include or exclude in the CTC-generated circuit route.

• Review Route Before Creation—Check this check box if you want to review and edit the circuit 
route before the circuit is created.

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. CTC creates a fully-protected circuit route based on the path diversity option you choose. 
Fully-protected paths may or may not have path protection path segments (with primary and 
alternate paths), and the path diversity options apply only to path protection path segments, if any 
exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 13. 

Caution Circuits routed on BLSR protection channels are not protected. They are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path in Step 10, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.
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• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Figure 5-2 Setting Circuit Routing Preferences for a DS-1 Circuit

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.

Step 13 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps. If not, continue 
with Step 16.

a. Click Next.

b. In the Circuit Route Constraints area, click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit will be routed. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node from the Required 
Nodes/Lines or Excluded Notes Links lists and click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 14 Click Next. On the VT Circuit panel in the Create area, choose one of the following:

• VT Tunnel on Transit Nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15327s without consuming cross-connect card resources. VT tunnels can carry 28 
VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT circuits 
from the same source and destination. Refer to the Cisco ONS 15327 Reference Manual for more 
information.

• VT Aggregation Point—This option is available if you are creating a DS-1 circuit to an OC-N port. 
A VT aggregation point (VAP) allows VT1.5 circuits to be routed through a node using one STS 
connection on the cross-connect card matrix rather than multiple connections on the VT1.5 matrix. 
If available, choose one of the following:

– Use source as the STS grooming end—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an OC-N card.
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– Use destination as the STS grooming end—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This will be the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 15 If you chose VT Aggregation Point, complete the following substeps. If not, continue with Step 16.

a. Click Next.

b. On the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 16 If you selected Review Route Before Creation in Step 9, complete the following substeps. If not, 
continue with Step 17. 

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-B182 Create a Manually Routed DS-1 Circuit” procedure on page 5-10.

Step 17 Click Finish. One of the following results occurs, depending on the circuit properties you chose in the 
Circuit Creation dialog box:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in the Number of Circuits field. If auto ranging 
cannot complete all the circuits, for example, because sequential ports are unavailable at the source 
or destination, a dialog box appears. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto ranging.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box appears for you to create the remaining circuits. Repeat this procedure 
for each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 18 On the Circuits window, verify that the new circuit(s) appear in the circuits list.

Step 19 Complete the “NTP-B135 Test Electrical Circuits” procedure on page 5-37. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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NTP-B182 Create a Manually Routed DS-1 Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3. CTC 
will assign a circuit name automatically based on circuit type, node name, and sequence number.

Step 3 From the View menu choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (see Figure 5-1 on page 5-7), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 15327 network.

• Size—VT1.5 is the default. You cannot change it.

• Bidirectional—Leave checked for this circuit.

• Number of circuits—Type the number of DS-1 circuits you want to create. The default is 1. 

• Auto-ranged—Applies to automatically-routed circuits only. If you entered more than 1 in Number 
of Circuits, uncheck this check box. (The check box is unavailable if only one circuit is entered in 
Number of Circuits.)

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS will change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15327 Reference Manual for more information.

Purpose This procedure creates a DS-1 circuit and provision its circuit route.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is unchecked, CTC will not change the 
state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed on protected drops only, that 
is, to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards and ports as source and destination choices.

Step 6 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27. Otherwise, continue with the next step.

Step 7 Click Next. 

Step 8 Complete the “DLP-B95 Provision a DS-1 Circuit Source and Destination” task on page 5-17.

Step 9 In the Circuit Routing Preferences area (see Figure 5-2 on page 5-8), uncheck Route Automatically. 

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection segments (with primary and 
alternate paths), and the path diversity options apply only to path protection segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 15. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose a Node-Diverse Path option: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.
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Step 13 Click Next. On the VT Circuit panel in the Create area, choose one of the following:

• VT Tunnel on Transit Nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15327s without consuming cross-connect card resources. VT tunnels can carry 28 
VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT circuits 
from the same source and destination. Refer to the Cisco ONS 15327 Reference Manual for more 
information.

• VT Aggregation Point—This option is available if you are creating a DS-1 circuit to an OC-N port. 
A VT aggregation point (VAP) allows VT1.5 circuits to be routed through a node using one STS 
connection on the cross-connect card matrix rather than multiple connections on the VT1.5 matrix. 
If available, choose one of the following:

– Use source as the STS grooming end—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an OC-N card.

– Use destination as the STS grooming end—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This will be the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 14 If you chose VT Aggregation Point, complete the following substeps. If not, continue with Step 16.

a. Click Next.

b. On the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 15 Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit. The circuit 
source node is selected. Green arrows pointing from the source node to other network nodes indicate 
spans that are available for routing the circuit. 

Step 16 Complete the “DLP-B96 Provision a DS-1 or DS-3 Circuit Route” task on page 5-29 for the DS-1 circuit 
you are creating. 

Step 17 Click Finish. CTC will compare your manually-provisioned circuit route with the specified path 
diversity option you chose in Step 11. If the path does not meet the specified path diversity requirement, 
CTC displays an error message and allows you to change the circuit path. If you entered more than 1 in 
the Number of Circuits field, the Circuit Creation dialog box appears for you to create the remaining 
circuits. Repeat this procedure for each additional circuit.

Step 18 When all the circuits are created, the main Circuits window appears. Verify that the circuit(s) you created 
are correct.

Step 19 Complete the “NTP-B135 Test Electrical Circuits” procedure on page 5-37. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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NTP-B183 Create a Unidirectional DS-1 Circuit with Multiple 
Drops

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23at a node on the network where you will create 
the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3. 

Step 3 From the View menu choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-3), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose VT.

• Size—VT1.5 is the default. You cannot change it.

• Bidirectional—Uncheck for this circuit.

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS will change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15327 Reference Manual for more information.

Purpose This procedure creates a unidirectional DS-1 circuit with multiple drops 
(destinations).

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is unchecked, CTC will not change the 
state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this check box is checked, 
you cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations 
are unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected ports as source and destination choices.

Figure 5-3 Setting Circuit Attributes for a Unidirectional DS-1 Circuit

Step 6 Click Next. 

Step 7 Complete the “DLP-B95 Provision a DS-1 Circuit Source and Destination” task on page 5-17.

Step 8 In the Circuit Routing Preferences area, uncheck Route Automatically. When Route Automatically is 
not selected, Using Required Nodes/Spans and Review Route Before Circuit Creation are unavailable.

Step 9 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection segments (with primary and 
alternate paths), and the path diversity options apply only to path protection segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 15. 
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Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 10 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Step 11 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.

Step 12 Click Next. On the VT Circuit panel in the Create area, choose one of the following:

• VT Tunnel on Transit Nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15327s without consuming cross-connect card resources. VT tunnels can carry 28 
VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT circuits 
from the same source and destination. Refer to the Cisco ONS 15327 Reference Manual for more 
information.

• VT Aggregation Point—This option is available if you are creating a DS-1 circuit OC-N port. A VT 
aggregation point (VAP) allows VT1.5 circuits to be routed through a node using one STS 
connection on the cross-connect card matrix rather than multiple connections on the VT1.5 matrix. 
If available, choose one of the following:

– Use source as the STS grooming end—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an OC-N card.

– Use destination as the STS grooming end—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This will be the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 13 If you chose VT Aggregation Point, complete the following substeps. If not, continue with Step 16.

a. Click Next.

b. On the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 14 Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit manually. 
The circuit source node is selected. Green arrows pointing from the source node to other network nodes 
indicate spans that are available for routing the circuit. 

Step 15 Complete the “DLP-B96 Provision a DS-1 or DS-3 Circuit Route” task on page 5-29 for the DS-1 circuit 
you are creating. 

Step 16 Click Finish. CTC completes the circuit and displays the Circuits window.

Step 17 On the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search buttons become active.

Step 18 Click Edit (or double-click the circuit row). The Edit Circuit window appears with the General tab 
selected. 
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All nodes in the DCC network appear on the network map. Circuit source and destination information 
appears under the source and destination nodes. To display a detailed view of the circuit, click Show 
Detailed Map. To rearrange a node icon, select the node, press Ctrl, then drag and drop the icon to the 
new location.

Step 19 On the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.

Step 20 Click Create.

Step 21 On the Define New Drop dialog box, create the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot.

c. Port, STS, VT, or DS1—Choose the port, STS, VT, or DS1 from the Port, STS, VT or DS1 
drop-down menus. The card selected in Step b determines the fields that appear. See Table 5-2 on 
page 5-3 for a list of options.

d. The routing preferences for the new drop will match those of the original circuit. However, you can 
modify the following: 

– If the original circuit was routed on a protected path, you can change the nodal diversity options: 
[Required, Desired, Don’t Care; Link Diverse only]. See Step 10 for options descriptions. 

– If the original circuit was not routed on a protected path, the Protection Channel Access options 
is available. See Step 9 for a description of the PCA option.

e. Click OK. The new drop appears in the Drops list.

Step 22 If you need to create additional drops for the circuit, repeat Steps 20 and 21 to create the additional drops.

Step 23 Choose Close. The Circuits window appears.

Step 24 Verify that the new drops appear in the Destination column for the circuit you edited. If they do not 
appear repeat Steps 5 through 22, making sure all options are provisioned correctly.

Step 25 Complete the “NTP-B135 Test Electrical Circuits” procedure on page 5-37. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

DLP-B314 Assign a Name to a Port

Step 1 Double-click the OC-N or XTC card that has the port you want to provision.

Step 2 Click the Provisioning tab.

Step 3 Click the Port Name column for the port number you are assigning a name to and enter the desired port 
name. 

Purpose This task assigns a name to an ONS 15327 port. 

Tools/Equipment None

Prerequisite Procedures NTP-B24 Verify Card Installation, page 3-2

Required/As Needed As needed. 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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The port name can be up to 32 alphanumeric/special characters and is blank by default.

Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

DLP-B95 Provision a DS-1 Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node drop-down menu choose the node where the source will originate.

Step 2 From the Slot drop-down menu choose the slot containing the XTC card where the circuit will originate. 

Step 3 From the DS-1 drop-down menu choose the source DS-1.

Step 4 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Source and repeat Steps 1 through 3 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 5. 

Step 5 Click Next. 

Step 6 From the Node drop-down menu choose the destination (termination) node.

Step 7 From the Slot drop-down menu choose the slot containing the destination card. The destination is 
typically an XTC card. You can also choose an OC-N card to map the DS-1 to a VT1.5 for optical 
transport.

Step 8 Depending on the destination card, choose the destination port, STS, VT, or DS1 from the sub-menus 
that appear based on the card selected in Step 7. See Table 5-2 on page 5-3 for a list of valid options. 
CTC does not display ports, STSs, VTs, or DS1s already used by other circuits. If you and a user working 
on the same network choose the same port, STS, VT, port, or DS1 simultaneously, one of you will receive 
a Path in Use error and be unable to complete the circuit. The user with the incomplete circuit needs to 
choose new destination parameters.

Step 9 If you need to create a secondary destination, for example, a path protection bridge/selector circuit exit 
point in a multivendor path protection, click Use Secondary Destination and repeat Steps 6–8 to define 
the secondary destination. 

Purpose This task provisions an electrical circuit source and destination for a DS-1 
circuit.

Tools/Equipment None

Prerequisite Procedures You perform this task during one of the following procedures: 

NTP-B181 Create an Automatically Routed DS-1 Circuit, page 5-5, or

NTP-B182 Create a Manually Routed DS-1 Circuit, page 5-10, or

NTP-B183 Create a Unidirectional DS-1 Circuit with Multiple Drops, page 
5-13

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 10 Click Next. 

Step 11 Return to your originating procedure (NTP).

NTP-B184 Create an Automatically Routed DS-3 Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-4), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. STS cross-connects will carry the DS-3 circuit across the ONS 15327 network.

• Size—Choose STS-1.

• Bidirectional—Leave checked for this circuit.

• Number of circuits—Type the number of DS-3 circuits you want to create. The default is 1. If you 
are creating multiple circuits with sequential source and destination ports, you can use Auto-ranged 
to create the circuits automatically. 

• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
circuits field. Leave selected if you are creating multiple DS-3 circuits with the same source and 
destination and you want CTC to create the circuits automatically. Uncheck this check box if you 
do not want CTC to create sequential circuits automatically.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

Purpose This procedure creates an automatically routed DS-3 circuit. CTC routes 
the circuit automatically based on circuit creation parameters and the 
software version.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
5-18
Cisco ONS 15327 Procedure Guide, R4.0

March 2003



 

Chapter 5      Create Circuits and VT Tunnels
NTP-B184 Create an Automatically Routed DS-3 Circuit
– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is unchecked, CTC will not change the 
state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed on protected drops only, that 
is, to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards and ports as source and destination choices.

Figure 5-4 Setting Circuit Attributes for a DS-3

Step 6 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 7 Click Next. 

Step 8 Complete the “DLP-B208 Provision a DS-3 Circuit Source and Destination” task on page 5-28.

Step 9 In the Circuit Routing Preferences area (Figure 5-5 on page 5-20), choose Route Automatically. Two 
options are available; choose either, both, or none based on your preferences.:
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• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

• Review Route Before Creation—Check this check box to review and edit the circuit route before the 
circuit is created.

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 14. CTC creates a fully-protected circuit route based on the path diversity option you choose. 
Fully-protected paths may or may not have path protection segments (with primary and alternate 
paths), and the path diversity options apply only to path protection segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 13. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path in Step 10, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Figure 5-5 Setting Circuit Routing Preferences for a DS-3 Circuit

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.
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Step 13 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps; otherwise, 
continue with Step 14:

a. Click Next. 

b. In the Circuit Route Constraints area, click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans determines the circuit 
sequence. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node from the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Note If a node or span stays gray, that node or span is required.

Step 14 If you selected Review Route Before Creation, complete the following substeps; otherwise, continue 
with Step 15.

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-B185 Create a Manually Routed DS-3 Circuit” procedure on page 5-22.

Step 15 Click Finish. One of the following actions occurs based on the circuit properties you selected:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in the Number of Circuits field. If auto ranging 
cannot complete all the circuits, for example, because sequential ports are unavailable at the source 
or destination, a dialog box appears. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto ranging.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box appears for you to create the remaining circuits. Repeat Steps 8–15 for 
each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 16 On the Circuits window, verify that the circuit(s) you just created appear in the circuits list.

Step 17 Complete the “NTP-B135 Test Electrical Circuits” procedure on page 5-37. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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NTP-B185 Create a Manually Routed DS-3 Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 3.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 4.

Step 3 From the View menu choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-4 on page 5-19), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave this field blank, CTC will assign a default name to the circuit.

• Type—Choose STS. STS cross-connects will carry the DS-3 circuit across the ONS 15327 network.

• Size—Choose STS-1.

• Bidirectional—Leave this field checked.

• Number of circuits—Type the number of DS-3 circuits you want to create. The default is 1. 

• Auto-ranged—Applies to automatically-routed circuits only. If you entered more than 1 in Number 
of Circuits, uncheck this check box. (The check box is unavailable if only one circuit is entered in 
Number of Circuits.)

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is unchecked, CTC will not change the 
state of the source and destination ports.

Purpose This procedure creates a DS-3 circuit and allows you to choose the circuit 
route.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards as source and destination choices.

Step 6 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 7 Click Next. 

Step 8 Complete the “DLP-B208 Provision a DS-3 Circuit Source and Destination” task on page 5-28.

Step 9 In the Circuit Routing Preferences area (Figure 5-5 on page 5-20), uncheck Route Automatically. 

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection segments (with primary and 
alternate paths), and the path diversity options apply only to path protection segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 13.

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection ring interconnect 
(DRI), check the Dual Ring Interconnect check box.

Step 13 Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit manually. 
The green arrows pointing from the selected node to other network nodes indicate spans that are 
available for routing the circuit. 

Step 14 Complete the “DLP-B96 Provision a DS-1 or DS-3 Circuit Route” task on page 5-29 for the DS-3 circuit 
you are creating.
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Step 15 Click Finish. If you entered more than 1 in the Number of Circuits field, the Circuit Creation dialog box 
appears for you to create the remaining circuits. Repeat this procedure for each additional circuit.

Step 16 When all the circuits are created, CTC displays the main Circuits window. Verify that the circuit(s) you 
created appear in the window.

Step 17 Complete the “NTP-B135 Test Electrical Circuits” procedure on page 5-37. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

NTP-B186 Create a Unidirectional DS-3 Circuit with Multiple 
Drops

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-6 on page 5-25), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. 

• Size—Choose STS-1.

• Bidirectional—Uncheck for this circuit.

• Number of circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable when the Number of Circuits is 1.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

Purpose This procedure creates a unidirectional DS-3 circuit with multiple drops.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is unchecked, CTC will not change the 
state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards as source and destination choices.

Figure 5-6 Setting Circuit Attributes for a Unidirectional DS-3 Circuit

Step 6 If the circuit will be routed on a path protection, set the path protection selectors. See the “DLP-B218 
Provision Path Protection Selectors During Circuit Creation” task on page 5-27.

Step 7 Click Next. 

Step 8 Complete the “DLP-B208 Provision a DS-3 Circuit Source and Destination” task on page 5-28.

Step 9 Uncheck Route Automatically. When Route Automatically is not selected, Using Required 
Nodes/Spans and Review Route Before Circuit Creation are unavailable. 
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Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection segments (with primary and 
alternate paths), and the path diversity options apply only to path protection segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 13. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.

Step 13 Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit manually. 
The circuit source node is selected. Green arrows pointing from the source node to other network nodes 
indicate spans that are available for routing the circuit.

Step 14 Complete the “DLP-B96 Provision a DS-1 or DS-3 Circuit Route” task on page 5-29 for the DS-3 you 
are creating.

Step 15 Click Finish. After completing the circuit, CTC displays the Circuits window.

Step 16 On the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search radio buttons become active.

Step 17 Click Edit. The Edit Circuit window appears with the General tab selected. All nodes in the DCC 
network appear on the network map. Circuit source and destination information appears under the source 
and destination nodes. To display a detailed view of the circuit, click Show Detailed Map. You can 
rearrange the node icons by selecting the node with the left mouse button while simultaneously pressing 
Ctrl, then dragging the icon to the new location.

Step 18 On the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.

Step 19 Click Create.

Step 20 On the Define New Drop dialog box, define the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot

c. Port, STS—Choose the port and/or STS from the Port and STS drop-down menus. The card selected 
in Step b determines whether port, STS, or both display. See Table 5-2 on page 5-3 for a list of 
options.
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d. The routing preferences for the new drop will match those of the original circuit. However, you can 
modify the following: 

– If the original circuit was routed on a protected path, you can change the nodal diversity options: 
[Required, Desired, Don’t Care; Link Diverse only]. See Step 11 for options descriptions. 

– If the original circuit was not routed on a protected path, the Protection Channel Access options 
is available. See Step 10 for a description of the PCA option.

e. Click OK. The new drop appears in the Drops list.

Step 21 If you need to create additional drops for the circuit, repeat Steps 19 and 20 to create the additional drops.

Step 22 Click Close. The Circuits window displays.

Step 23 Verify that the new drops appear in the Destination column for the circuit you edited. If they do not 
appear, repeat this procedure, making sure all options are provisioned correctly.

Step 24 Complete the “NTP-B135 Test Electrical Circuits” procedure on page 5-37. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

DLP-B218 Provision Path Protection Selectors During Circuit Creation

Step 1 On the Circuit Attributes panel of the Circuit Creation wizard, set the path protection selectors:

• Revertive—Check this check box if you want traffic to revert to the working path when the 
conditions that diverted it to the protect path are repaired. If you do not choose Revertive, traffic 
remains on the protect path after the switch.

• Reversion time—If Revertive is checked, click the Reversion time field and choose a reversion time 
from the drop-down menu. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the 
amount of time that will elapse before the traffic reverts to the working path. Traffic can revert when 
conditions causing the switch are cleared.

• SF threshold—For STS circuits, set the path protection path-level signal failure bit error rate (BER) 
thresholds. Unavailable for VT circuits.

• SD threshold—For STS circuits, set the path protection path-level signal degrade BER thresholds. 
Unavailable for VT circuits.

• Switch on PDI-P—For STS circuits, check this check box if you want traffic to switch when an STS 
payload defect indicator is received. Unavailable for VT circuits.

Step 2 Return to your originating procedure (NTP).

Purpose This task provisions path protection selectors during circuit creation. 
Complete this task only if the circuit will be routed on a path protection.

Tools/Equipment None

Prerequisite Procedures You must have the Circuit Creation wizard displayed.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-B208 Provision a DS-3 Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node drop-down menu choose the node where the source will originate.

Step 2 From the Slot drop-down menu choose the slot containing the XTC card where the circuit will originate 

Step 3 From the Port drop-down menu choose the source XTC card as appropriate.

Step 4 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Source and repeat Steps 1 through 3 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 5. 

Step 5 Click Next. 

Step 6 From the Node drop-down menu choose the destination (termination) node.

Step 7 From the Slot drop-down menu choose the slot containing the destination card. The destination is 
typically a XTC card. You can also choose an OC-N card to the map DS-3 circuit to an STS.

Step 8 Depending on the destination card, choose the destination port or STS from the sub-menus that display 
based on the card selected in Step 3. See Table 5-2 on page 5-3 for a list of valid options. CTC does not 
display ports, STSs, VTs, or DS1s if they are already in use by other circuits. If you and a user working 
on the same network choose the same port, STS, VT, port, or DS1 simultaneously, one of you will receive 
a Path in Use error and be unable to complete the circuit. The user with the incomplete circuit needs to 
choose new destination parameters.

Step 9 If you need to create a secondary destination, for example, a path protection bridge/selector circuit exit 
point in a multivendor path protection, click Use Secondary Destination and repeat Steps 6 and 7 to 
define the secondary destination. 

Step 10 Click Next. 

Step 11 Return to your originating procedure (NTP).

Purpose This task provisions an electrical circuit source and destination for a DS-3 
circuit.

Tools/Equipment None

Prerequisite Procedures You perform this task during one of the following procedures:

NTP-B184 Create an Automatically Routed DS-3 Circuit, page 5-18, or

NTP-B185 Create a Manually Routed DS-3 Circuit, page 5-22, or

NTP-B186 Create a Unidirectional DS-3 Circuit with Multiple Drops, page 
5-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-B96 Provision a DS-1 or DS-3 Circuit Route

Step 1 On the Circuit Creation wizard in the Route Review and Edit area, click the source node icon if it is not 
already selected.

Step 2 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns white. In the Selected Span area, the From and To fields display span information. The 
source STS and VT (DS-1 circuit only) appear. 

Step 3 If you want to change the source STS, adjust the Source STS field; otherwise, continue with Step 4.

Step 4 If you want to change the source VT for DS-1 circuits, adjust the Source VT field; otherwise, continue 
with Step 5.

Note VT is gray (unavailable) for DS-3 circuits.

Step 5 Click Add Span.The span is added to the Included Spans list and the span arrow turns blue. 

Step 6 Repeat Steps 2 through 5 until the circuit is provisioned from the source to the destination node through 
all intermediary nodes. If the Fully Protect Path field is checked on the Circuit Routing Preferences 
panel, you must:

• Add two spans for all path protection or unprotected portions of the circuit route from the source to 
the destination

• Add one span for all BLSR or 1+1 portions of route from the source to the destination

Step 7 Return to your originating procedure (NTP).

Purpose This task provisions the circuit route for manually-routed DS-1 or DS-3 
circuits.

Tools/Equipment None

Prerequisite Procedures You perform this task during one of the following procedures:

NTP-B182 Create a Manually Routed DS-1 Circuit, page 5-10, or

NTP-B183 Create a Unidirectional DS-1 Circuit with Multiple Drops, page 
5-13, or

NTP-B185 Create a Manually Routed DS-3 Circuit, page 5-22, or

NTP-B186 Create a Unidirectional DS-3 Circuit with Multiple Drops, page 
5-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-B133 Create an Automatically Routed VT Tunnel

Note VT tunnels allow VT circuits to pass through intermediary ONS 15327s without consuming VT matrix 
resources on the cross-connect card. VT tunnels can carry 28 VT1.5 circuits. In general, creating VT 
tunnels is a good idea if you are creating many VT circuits from the same source and destination. Refer 
to the Circuits and Tunnels chapter in the Cisco ONS 15327 Reference Manual for more information.

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-7), complete the following fields: 

• Name—Assign a name to the VT tunnel. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the tunnel.

• Type—Choose VT Tunnel. The Bidirectional, Number of Circuits, Field Size, and Create 
cross-connects fields in the dialog box become unavailable.

• Size—Unavailable for VT tunnels.

• Bidirectional—Unavailable for VT tunnels.

• Number of circuits—Unavailable for VT tunnels.

• Auto-ranged—Unavailable for VT tunnels.

• State—Choose a service state to apply to the VT tunnel:

– IS—The VT tunnel is in service.

– OOS—The VT tunnel is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VT tunnel is in service when it receives a valid signal; until then, the tunnel 
is out of service.

– OOS-MT—The VT tunnel is in a maintenance state. The maintenance state does not interrupt 
traffic flow; it suppresses alarms and conditions and permits loopbacks on the tunnel. Use 
OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, 
OOS, or OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task 
on page 8-8.

• Apply to drop ports—Uncheck this check box.

Purpose This procedure creates an automatically routed VT tunnel from source to 
destination nodes.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Inter-domain (UCP) SLA—If the tunnel will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

Figure 5-7 Setting Attributes for a VT Tunnel

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the node where the VT tunnel will originate from the Node drop-down 
menu. 

Step 8 Click Next.

Step 9 In the Circuit Destination area, choose the node where the VT tunnel will terminate from the Node 
drop-down menu.

Step 10 Click Next.

Step 11 In the Circuit Routing Preferences area, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated tunnel route.

• Review Route Before Creation—Check this check box to review and edit the VT tunnel route before 
the circuit is created.

Step 12 If you selected Using Required Nodes/Spans:

a. Click Next.

b. In the Circuit Route Constraints area, click a span on the VT tunnel map.

c. Click Include to include the node or span in the VT tunnel. Click Exclude to exclude the node or 
span from the VT tunnel. The order in which you choose included nodes and spans sets the VT 
tunnel sequence. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the VT tunnel route. To change the tunnel routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the tunnel 
routing order. Click Remove to remove a node or span.

Step 13 If you selected Review Route Before Creation:

a. Click Next.
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b. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route. Blue 
arrows show the tunnel route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned tunnel does not reflect the routing and configuration you want, click Back to 
verify and change tunnel information.

Step 14 Click Finish. The Circuits window displays.

Step 15 Verify that the tunnel you just created appears in the circuits list. VT tunnels are identified by VTT in 
the Type column.

Stop. You have completed this procedure.

NTP-B134 Create a Manually Routed VT Tunnel

Note VT tunnels allow VT circuits to pass through intermediary ONS 15327s without consuming VT matrix 
resources on the cross-connect card. VT tunnels can carry 28 VT1.5 circuits. In general, creating VT 
tunnels is a good idea if you are creating many VT circuits from the same source and destination. Refer 
to the Circuits and Tunnels chapter in the Cisco ONS 15327 Reference Manual for more information.

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-1 on page 5-7), complete the following fields: 

• Name—Assign a name to the VT tunnel. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the tunnel.

• Type—Choose VT Tunnel. The Bidirectional, Number of Circuits, Field Size, and Create 
cross-connects fields in the dialog box become unavailable (grayed out).

• Size—Unavailable for VT tunnels.

• Bidirectional—Unavailable for VT tunnels.

• Number of circuits—Unavailable for VT tunnels.

Purpose This procedure creates a manually routed VT tunnel from source to 
destination nodes.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Auto-ranged—Unavailable for VT tunnels.

• State—Choose a service state to apply to the VT tunnel:

– IS—The VT tunnel is in service.

– OOS—The VT tunnel is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VT tunnel is in service when it receives a valid signal; until then, the circuit 
is out of service.

– OOS-MT—The VT tunnel is in a maintenance state. The maintenance state does not interrupt 
traffic flow; it suppresses alarms and conditions and permits loopbacks. Use OOS-MT for 
testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or OOS-AINS 
when testing is complete. See the “DLP-B230 Change a Circuit State” task on page 8-8.

• Apply to drop ports—Uncheck this check box.

– Inter-domain (UCP) SLA—If the tunnel will travel on a unified control plane (UCP) channel, 
enter the service level agreement number. Otherwise, leave the field set to zero. 

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the node where the VT tunnel will originate from the Node drop-down 
menu. 

Step 8 Click Next.

Step 9 In the Circuit Destination area, choose the node where the VT tunnel will terminate from the Node 
drop-down menu. 

Step 10 Click Next.

Step 11 In the Circuit Routing Preferences area, uncheck Route Automatically.

Step 12 Click Next. In the Route Review and Edit area, node icons appear to route the tunnel. The circuit source 
node is selected. Green arrows pointing from the source node to other network nodes indicate spans that 
are available for routing the tunnel. 

Step 13 Complete the “DLP-B219 Provision a VT Tunnel Route” task on page 5-34 for the tunnel you are 
creating. The Circuits window displays.

Step 14 Verify that the tunnel you just created appears in the circuits list. VT tunnels are identified by VTT in 
the Type column.

Stop. You have completed this procedure.
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DLP-B219 Provision a VT Tunnel Route

Step 1 On the Circuit Creation wizard in the Route Review and Edit area, click the source node icon if it is not 
already selected. Arrows indicate the available spans for routing the tunnel from the source node.

Step 2 Click the arrow of the span you want the VT tunnel to travel. The arrow turns white. In the Selected Span 
area, the From and To fields display the slot and port that will carry the tunnel. The source STS appears. 
Figure 5-8 shows an example.

Figure 5-8 Manually Routing a VT Tunnel

Step 3 If you want to change the source STS, change it in the Source STS field; otherwise, continue with the 
next step.

Step 4 Click Add Span.The span is added to the Included Spans list and the span arrow turns blue. 

Step 5 Repeat Steps 3 and 4 until the tunnel is provisioned from the source to the destination node through all 
intermediary nodes.

Step 6 Return to the “NTP-B134 Create a Manually Routed VT Tunnel” procedure on page 5-32.

Purpose This task provisions the route for a manually-routed VT tunnel.

Tools/Equipment None

Prerequisite Procedures Perform this task as part of the “NTP-B134 Create a Manually Routed VT 
Tunnel” procedure on page 5-32.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-B187 Create a VT Aggregation Point

Note The maximum number of VAPs that you can create depends on the node protection topology and number 
of VT1.5 circuits that terminate on the node. Assuming no other VT1.5 circuits terminate at the node, 
the maximum number of VAPs that you can terminate at one node is 8 for 1+1 and path protection and 
12 for BLSR protection. 

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-9 on page 5-36), complete the following fields: 

• Name—Assign a name to the VT aggregation point. The name can be alphanumeric and up to 48 
characters (including spaces). Circuit names should be 44 characters or less if you want the ability 
to create monitor circuits. If you leave the field blank, CTC assigns a default name to the VAP.

• Type—Choose VT Aggregation Point. The Size, Bidirectional, Number of Circuits, and Create 
cross-connects fields in the dialog box become unavailable.

• Size—Unavailable for VAPs.

• Bidirectional—Unavailable for VAPs.

• Number of circuits—Unavailable for VAPs.

• Auto-ranged—Unavailable for VAPs.

• State—Choose a service state to apply to the VAP:

– IS—The VAP is in service.

– OOS—The VAP is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VAP is in service when it receives a valid signal; until then, the tunnel is out 
of service.

– OOS-MT—The VAP is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the VAP. Use OOS-MT for 
circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

Purpose This procedure creates a VT aggregation point (VAP). VAPs allow multiple 
DS-1 (VT1.5) circuits to be aggregated on a single STS on an OC-N card. 
VAPs allow multiple VT1.5 circuits to pass through cross-connect cards 
without utilizing resources on the cross-connect card VT matrix.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Uncheck this check box.

• Inter-domain (UCP) SLA—If the VAP will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

Figure 5-9 Setting Attributes for a VT Aggregation Point

Step 6 If the VAP will be routed on a path protection, set the path protection path selectors. See the “DLP-B218 
Provision Path Protection Selectors During Circuit Creation” task on page 5-27.

Step 7 Click Next. 

Step 8 In the Circuit Source area, choose the source node, slot, port, and STS for the VAP. The VAP source is 
where the DS-1 (VT1.5) circuits will be aggregated into a single STS. The VAP destination is where the 
DS-1 circuits originate.

a. From the Node drop-down menu choose the node where the VAP will originate.

b. From the Slot drop-down menu choose the slot containing the OC-N card where the VAP will 
originate. 

c. From the STS drop-down menu choose the source STS.

Step 9 Click Next.

Step 10 In the Circuit Destination area, choose the node where the VT circuits aggregated by the VAP will 
terminate from the Node drop-down menu.

Step 11 Click Next.

Step 12 In the Circuit Routing Preferences area, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated tunnel route.

• Review Route Before Creation—Check this check box to review and edit the VT tunnel route before 
the circuit is created.

Step 13 If you selected Using Required Nodes/Spans:

a. Click Next.

b. In the Circuit Route Constraints area, click a span on the VAP map.
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c. Click Include to include the node or span in the VAP. Click Exclude to exclude the node or span 
from the VAP. The sequence in which you choose the nodes and spans sets the VAP sequence. Click 
spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the VAP route. To change the tunnel routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the tunnel 
routing order. Click Remove to remove a node or span.

Step 14 If you selected Review Route Before Creation:

a. Click Next.

b. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route. Blue 
arrows show the tunnel route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned tunnel does not reflect the routing and configuration you want, click Back to 
verify and change tunnel information.

Step 15 Click Finish. The Circuits window displays.

Step 16 Verify that the VAP you just created appears in the circuits list. VAPs are identified in the Type column.

Stop. You have completed this procedure.

NTP-B135 Test Electrical Circuits

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you created 
the circuit(s). If you are already logged in, continue with Step 2.

Step 2 From the View menu choose Go to Network View.

Step 3 Click the Circuit tab. 

Purpose This procedure tests DS-1 and DS-3 circuits.

Tools/Equipment A test set and all appropriate cables

Prerequisite Procedures This procedure assumes you completed a facility loopback tests on the 
fibers and cables from the source and destination ONS 15327s to the DSX, 
and that you created a circuit using one of the following procedures:
NTP-B181 Create an Automatically Routed DS-1 Circuit, page 5-5
NTP-B182 Create a Manually Routed DS-1 Circuit, page 5-10
NTP-B183 Create a Unidirectional DS-1 Circuit with Multiple Drops, page 
5-13
NTP-B184 Create an Automatically Routed DS-3 Circuit, page 5-18
NTP-B185 Create a Manually Routed DS-3 Circuit, page 5-22
NTP-B186 Create a Unidirectional DS-3 Circuit with Multiple Drops, page 
5-24

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 4 Set the circuit and circuit ports to the maintenance state (OOS-MT). Take note of the original state 
because you will return the circuit to that state later.

a. Click the circuit you want to test then choose Circuits > Set Circuit State from the Tools menu.

b. On the Set Circuit State dialog box, choose OOS-MT from the Target State drop-down menu.

c. Check the Apply to drop ports check box.

d. Click Apply.

Step 5 Set the source and destination DS-1 port line length:

a. In network view, double-click the source node.

b. Double-click the circuit source XTC card and click the Provisioning > Line tabs.

c. From the circuit source port Line Length drop-down menu choose the line length for the distance 
(in feet) between the DSX (if used) or circuit termination point and the source ONS 15327.

d. Click Apply.

e. From the View menu choose Go to Network View.

f. Repeat Steps a. through e. for the destination port line length.

Step 6 Attach loopback cables to the circuit destination card. 

a. Verify the integrity of the loopback cable by looping the test set transmit (TX) connector to the test 
set receive (RX) connector. If the test set does not run error-free, check the cable for damage and 
check the test set to make sure it is set up correctly before going to Step b.

b. Attach the loopback cable to the port you are testing. Connect the transmit (TX) connector to the 
receive (RX) connector of the port. 

Step 7 Attach loopback cables to the circuit source node.

a. Verify the integrity of loopback cable by looping the test set transmit (TX) connector to the test set 
receive (RX) connector. If the test set does not run error-free, check the cable for damage and check 
the test set to make sure it is set up correctly before going to Step b.

b. Attach the loopback cable to the port you are testing. Connect the test set to the circuit source port: 
transmit (TX) port of the test set to the circuit receive (RX) port; test set receive (RX) port to the 
circuit transmit (TX) port. 

Step 8 Configure the test set for the ONS 15327 card that is the source of the circuit you are testing:

• DS-1—If you are testing an unmuxed DS-1, you must have a DSX-1 panel or a direct DS-1 interface 
into the ONS 15327. Set the test set for DS-1. For information about configuring your test set, 
consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15327. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

Step 9 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 2 through 
8 to make sure the test set and cabling is configured correctly. 

Step 10 Inject errors from the test set. Verify that the errors display at the source and destination nodes. 

Step 11 Clear the PMs for the ports that you tested. See the “DLP-B130 Clear Selected PM Counts” task on 
page 7-11 for instructions.

Step 12 Return the circuit and circuit ports to the state they were in at the beginning of the test:

a. Click the circuit you want to test then choose Circuits > Set Circuit State from the Tools menu.
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b. In the Set Circuit State dialog box, choose IS (in service), OOS (out of service) or OOS-AINS (auto 
in service) from the Target State drop-down menu.

c. Check the Apply to drop ports check box.

d. Click Apply.

Step 13 Perform the protection switch test appropriate to the SONET topology:

• For path protection, complete the “DLP-B94 Path Protection Switching Test” task on page 4-26

• For BLSRs complete the “DLP-B91 BLSR Ring Switch Test” task on page 4-20.

Step 14 Perform a bit error rate test (BERT) for 12 hours or follow your site requirements for length of time. For 
information about configuring your test set for BERT, see your test set user guide.

Step 15 After the BERT is complete, print the results or save them to a disk for future reference. For information 
about printing or saving test results see your test set user guide. 

Stop. You have completed this procedure.

NTP-B188 Create an Automatically Routed Optical Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23at a node on the network where you will create 
the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 5-10 on page 5-41), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. 

• Size—Choose the optical circuit size: STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, 
STS-48c.

• Bidirectional—Leave checked for this circuit.

Purpose This procedure creates an automatically-routed bidirectional or 
unidirectional optical circuit, including STS-1 and concatenated STS-3c, 
STS-6c, STS-9c, STS-12c, STS-24c, or STS-48c speeds.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Number of circuits—Type the number of optical circuits you want to create. The default is 1. If you 
are creating multiple circuits with the same source and destination, you can use auto-ranging to 
create the circuits automatically. 

• Auto-ranged—This check box is automatically checked when you enter more than 1 in the Number 
of circuits field. Leave checked if you are creating multiple optical circuits with the same source and 
destination and you want CTC to create the circuits automatically. Uncheck this check box if you 
do not want CTC to create the circuits automatically.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is unchecked, CTC will not change the 
state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protected drops only, that 
is, to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards as source and destination choices.
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Figure 5-10 Setting Circuit Attributes for an Optical Circuit

Step 6 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 7 Click Next. 

Step 8 Complete the “DLP-B97 Provision an Optical Circuit Source and Destination” task on page 5-48 for the 
optical circuit you are creating.

Step 9 In the Circuit Routing Preferences area (Figure 5-11), choose Route Automatically. Two options are 
available; choose either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

• Review Route Before Creation—Check this check box to review and edit the circuit route before the 
circuit is created.

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. CTC creates a fully-protected circuit route based on the path diversity option you choose. 
Fully-protected paths may or may not have path protection path segments (with primary and 
alternate paths), and the path diversity options apply only to path protection path segments, if any 
exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 13. 

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.
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Figure 5-11 Setting Circuit Routing Preferences for an Optical Circuit

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.

Step 13 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps. If not, continue 
with Step 14:

a. Click Next.

b. In the Circuit Route Constraints area, click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit, or click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit will be routed. Click spans twice to change the circuit direction. 

d. Repeat Step c. for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 14 If you selected Review Route Before Creation in Step 9, complete the following substeps; otherwise, 
continue with Step 15:

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-B189 Create a Manually Routed Optical Circuit” procedure on page 5-43 to assign the circuit 
route yourself.

Step 15 Click Finish. One of the following results occurs, based on the circuit properties you provisioned in the 
Circuit Creation dialog box:

• If you entered more than 1 in Number of circuits and selected Auto-ranged, CTC automatically 
creates the number of circuits entered in Number of circuits. If auto ranging cannot complete all the 
circuits, for example, because sequential ports are unavailable on the source or destination, a dialog 
box appears. Set the new source or destination for the remaining circuits, then click Finish to 
continue auto ranging.
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• If you entered more than 1 in Number of circuits and did not choose Auto-ranged, the Circuit 
Creation dialog box appears for you to create the remaining circuits. Repeat Steps Step 5 through 
15 for each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 16 On the Circuits window, verify that the circuit(s) you created appear in the circuits list.

Step 17 Complete the “NTP-B62 Test Optical Circuits” procedure on page 5-51. Skip this step if you built a test 
circuit.

Stop. You have completed this procedure.

NTP-B189 Create a Manually Routed Optical Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View. 

Step 4 In the Circuit Creation dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the optical circuit size. Choices are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, 
STS-24c, or STS-48c.

• Bidirectional—Leave checked for this circuit.

• Number of circuits—Type the number of optical circuits you want to create. The default is 1. 

• Auto-ranged—Applies to automatically-routed circuits only. If you entered more than 1 in Number 
of Circuits, uncheck this check box. (The check box is unavailable if only one circuit is entered in 
Number of Circuits.)

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

Purpose This procedure creates a manually-routed, bidirectional or unidirectional 
optical circuit, including STS-1 and concatenated STS-3c, STS-6c, 
STS-9c, STS-12c, STS-24c, or STS-48c speeds.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is not checked, CTC will not change 
the state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards as source and destination choices.

Step 5 If the circuit will be routed on a path protection, set the path protection path selectors. See the 
“DLP-B218 Provision Path Protection Selectors During Circuit Creation” task on page 5-27.

Step 6 Click Next.

Step 7 Complete the “DLP-B97 Provision an Optical Circuit Source and Destination” task on page 5-48 for the 
optical circuit you are creating.

Step 8 In the Circuit Routing Preferences area (Figure 5-11 on page 5-42), uncheck Route Automatically. 

Step 9 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 10. 

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 12.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 12. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 10 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse. 
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• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Step 11 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.

Step 12 Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit manually. 

Step 13 Complete the “DLP-B98 Provision an Optical Circuit Route” task on page 5-49.

Step 14 Click Finish. If the path does not meet the specified path diversity requirement, CTC displays an error 
message and allows you to change the circuit path. If you entered more than 1 in Number of circuits, the 
Circuit Creation dialog box appears after the circuit is created for you to create the remaining circuits. 

Step 15 Repeat Steps 4 through 14 for each additional circuit.

Step 16 When all the circuits are created, CTC displays the main Circuits window. Verify that the circuit(s) you 
created appear in the window.

Step 17 Complete the “NTP-B62 Test Optical Circuits” procedure on page 5-51.

Stop. You have completed this procedure.

NTP-B190 Create a Unidirectional Optical Circuit with Multiple 
Drops

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 From the View menu choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. 

Purpose This procedure creates a unidirectional OC-N circuit with multiple traffic 
drops (circuit destinations)

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Size—Choose the circuit size: STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, or STS-48c.

• Bidirectional—Uncheck this check box for this circuit.

• Number of circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the check box is not checked, CTC will not change 
the state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15327 cards that are in 1:1 or 1+1 protection. If you check this check box, CTC displays 
only protected cards as source and destination choices.

Step 6 If the circuit will be routed on a path protection, set the path protection path selectors. See the 
“DLP-B218 Provision Path Protection Selectors During Circuit Creation” task on page 5-27.

Step 7 Click Next. 

Step 8 Complete the “DLP-B97 Provision an Optical Circuit Source and Destination” task on page 5-48 for the 
circuit you are creating.

Step 9 Uncheck Route Automatically. When Route Automatically is not selected, Using Required 
Nodes/Spans and Review Route Before Circuit Creation are unavailable. 

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.
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• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, and then continue with 
Step 13. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths may be node-diverse, but CTC 
does not check for node diversity.

Note For manually-routed circuits, CTC checks your manually-provisioned path against the path 
diversity option you choose. If the path does not meet the path diversity requirement that is 
specified, CTC displays an error message.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection dual ring 
interconnect (DRI), check the Dual Ring Interconnect check box.

Step 13 Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit manually. 
The green arrows pointing from the selected node to other network nodes indicate spans that are 
available for routing the circuit. 

Step 14 Complete the “DLP-B98 Provision an Optical Circuit Route” task on page 5-49.

Step 15 Click Finish. After completing the circuit, CTC displays the Circuits window.

Step 16 On the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search buttons become active.

Step 17 Click Edit. The Edit Circuit window appears with the General tab selected. All nodes in the DCC 
network appear on the network. Circuit source and destination information appears under the source and 
destination nodes. To display a detailed view of the circuit, click Show Detailed Map. You can rearrange 
the node icons by selecting the node with the left mouse button, pressing Ctrl and dragging the icon to 
the new location.

Step 18 On the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.

Step 19 Click Create.

Step 20 On the Define New Drop dialog box, define the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot.

c. Port, STS—Choose the port and/or STS from the Port and STS drop-down menus. The choice in 
these menus depends on the card selected in Step b. See Table 5-2 on page 5-3 for a list of options.
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d. The routing preferences for the new drop will match those of the original circuit. However, you can 
modify the following: 

– If the original circuit was routed on a protected path, you can change the nodal diversity options: 
Required, Desired, Don’t Care; Link Diverse only. See Step 11 for options descriptions. 

– If the original circuit was not routed on a protected path, the Protection Channel Access options 
is available. See Step 13 for a description of the PCA option.

e. Click OK. The new drop appears in the Drops list.

Step 21 If you need to create additional drops on the circuit, repeat Steps 18 through 20.

Step 22 Click Close. The Circuits window appears.

Step 23 Verify that the new drops appear in the Destination column for the circuit you edited. If they do not 
appear, repeat Steps 19 through 22 making sure all options are provisioned correctly.

Step 24 Complete the “NTP-B62 Test Optical Circuits” procedure on page 5-51.

Stop. You have completed this procedure.

DLP-B97 Provision an Optical Circuit Source and Destination

Step 1 From the Node drop-down menu choose the node where the circuit will originate.

Step 2 From the Slot drop-down menu choose the slot containing the optical card where the circuit originates. 
(If a card’s capacity is fully utilized, it does not appear in the menu.)

Step 3 Depending on the circuit origination card, choose the source port and/or STS from the Port and STS 
sub-menus. The Port menu is only available if the card has multiple ports. STSs are not displayed if they 
are already in use by other circuits.

Note The STSs that display depend on the card, circuit size, and protection scheme. For example, if 
you create an STS-3c circuit on an OC-12 card in a path protection, only four STSs are available. 
If you create an STS-3c circuit on an OC-12 card in a BLSR, two STSs are available because of 
the BLSR protection characteristics.

Purpose This task provisions the source and destination cards for an optical circuit.

Tools/Equipment None

Prerequisite Procedures Perform this task during one of the following procedures:

NTP-B188 Create an Automatically Routed Optical Circuit, page 5-39

NTP-B189 Create a Manually Routed Optical Circuit, page 5-43

NTP-B190 Create a Unidirectional Optical Circuit with Multiple Drops, 
page 5-45

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Source and repeat Steps 1 through 3 to 
define the secondary source.

Step 5 Click Next.

Step 6 From the Node drop-down menu choose the destination node.

Step 7 From the Slot drop-down menu choose the slot containing the optical card where the circuit will 
terminate (destination card). (If a card’s capacity is fully utilized, the card does not appear in the menu.)

Step 8 Depending on the card selected in Step 2, choose the destination port and/or STS from the Port and STS 
sub-menus. The Port menu is available only if the card has multiple ports. The STSs that display depend 
on the card, circuit size, and protection scheme. 

Step 9 If you need to create a secondary destination, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Destination and repeat Steps 6 through 8 
to define the secondary destination. 

Step 10 Click Next.

Step 11 Return to your originating procedure (NTP).

DLP-B98 Provision an Optical Circuit Route

Step 1 On the Circuit Creation wizard in the Route Review and Edit area, click the source node icon if it is not 
already selected.

Step 2 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns white. In the Selected Span area, the From and To fields display span information. The 
source STS appears. Figure 5-12 shows an example.

Purpose This task provisions an optical circuit route for manually-routed circuits.

Tools/Equipment None

Prerequisite Procedures Perform this task during one of the following procedures:

NTP-B188 Create an Automatically Routed Optical Circuit, page 5-39

NTP-B189 Create a Manually Routed Optical Circuit, page 5-43

NTP-B190 Create a Unidirectional Optical Circuit with Multiple Drops, 
page 5-45

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 5-12 Manually Routing an OC-N Circuit

Step 3 If you want to change the source STS, adjust the Source STS field; otherwise, continue with the next 
step.

Note VT is gray for OC-N circuits.

Step 4 Click Add Span.The span is added to the Included Spans list and the span arrow turns blue. 

Step 5 Repeat Steps 2 through 4 until the circuit is provisioned from the source to the destination node through 
all intermediary nodes. If Fully Protect Path is checked on the Circuit Routing Preferences panel, you 
must:

• Add two spans for all path protection or unprotected portions of the circuit route from the source to 
the destination

• Add one span for all BLSR or 1+1 portions of route from the source to the destination

Suppose you want to create a fully protected circuit from a path protection node subtended from the 
BLSR. For example, a BLSR is comprised of Node 1, Node 2, and Node 3, and a path protection subtends 
from Node 3 to Node 4. To create a circuit from Node 4 to Node 1, you include two spans in the circuit 
route from Node 4 to Node 3, since both the working and protect path must be provisioned for the path 
protection portion of the circuit, and you provision one circuit span from Node 3 to Node 1, since the 
BLSR provides protection.

Step 6 Return to your originating procedure (NTP).
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NTP-B62 Test Optical Circuits

Note If this has not been done, do so now before completing the optical circuit test procedure.

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you created 
the circuit(s). If you are already logged in, continue with Step 2.

Step 2 From the View menu choose Go to Network View.

Step 3 Click the Circuits tab. 

Step 4 Set the circuit and circuit ports to Out of Service-Maintenance (OOS_MT):

a. Click the circuit you want to test.

b. From the Tools menu choose Circuits > Set Circuit State. 

c. In the Set Circuit State dialog box, choose OOS-MT from the Target State drop-down menu.

d. If it is unchecked, check the Apply to drop ports check box.

e. Click Apply.

Step 5 Set up the patch cable at the destination node: 

a. Test the patch cable by connecting one end to the test set transmit (TX) port and the other end to the 
test receive (RX) port. If the test set does not run error-free, check the cable for damage and check 
the test set to make sure it is set up correctly.

b. Install the loopback cable on the port you are testing. Connect the transmit (TX) to the receive (RX) 
of the port being tested.

Step 6 Set up the loopback cable at the source node:

a. Test the loopback cable by connecting one end to the test set transmit (TX) port and the other end 
to the test receive (RX) port. If the test set does not run error-free, check the cable for damage and 
check the test set to make sure it is set up correctly.

b. At the source node attach the loopback cable to the port you are testing. Connect the test set to the 
circuit source port: transmit (TX) port of the test set to the circuit receive (RX) port; test set receive 
(RX) port to the circuit transmit (TX) port. 

Purpose This procedure tests an optical circuit.

Tools/Equipment Test set capable of optical speeds, appropriate fibers, and attenuators

Prerequisite Procedures This procedure assumes you completed facility loopback tests to test the 
fibers and cables from the source and destination ONS 15327s to the fiber 
distribution panel or the DSX and one of following circuit procedures:

NTP-B188 Create an Automatically Routed Optical Circuit, page 5-39

NTP-B189 Create a Manually Routed Optical Circuit, page 5-43

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 7 Configure the test set for the source ONS 15327 card:

• OC-3 cards—You will test either an OC-3c (the “c” denotes concatenated) or a muxed OC-3. If you 
are testing an OC-3c, configure the test set for an OC-3c. If you are testing a muxed OC-3, configure 
the test set for a muxed OC-3 and choose the DS-3 and/or DS-1 you will test. For information about 
configuring your test set, consult your test set user guide.

• OC-12 cards—You will test either an OC-12c or a muxed OC-12. If you are testing an OC-12c, 
configure the test set for an OC-12c. If you are testing a muxed OC-12, configure the test set for a 
muxed OC12 and choose the DS-3 and/or DS-1 you will test. For information about configuring 
your test set, consult your test set user guide.

• OC-48 cards—You will test either an OC-48c or a muxed OC-48. If you are testing an OC-48c 
configure the test set for an OC-48c. If you are testing a muxed OC-48, configure the test set for a 
muxed OC-48 and choose the DS-3 and/or DS-1 you will test. For information about configuring 
your test set, consult your test set user guide.

Step 8 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 2 through 
7 to make sure you have configured the test set and cabling. 

Step 9 Inject errors from the test set. Verify that the errors display at the source and destination nodes. 

Step 10 Clear the PMs for the ports that you tested. See the “DLP-B130 Clear Selected PM Counts” task on 
page 7-11 for instructions.

Step 11 Perform protection switch testing appropriate to SONET topology:

• For path protection, see the “DLP-B94 Path Protection Switching Test” task on page 4-26.

• For BLSRs see the “DLP-B91 BLSR Ring Switch Test” task on page 4-20.

Step 12 Perform a bit error rate test (BERT) for 12 hours or a duration dictated by local testing custom. For 
information about configuring your test set for BERT, see your test set user guide.

Step 13 After the BERT is complete, print the results or save them to a disk for future reference. For information 
about printing or saving test results see your test set user guide. 

Step 14 Change the circuit and circuit ports from OOS_MT to their previous service states:

a. Click the circuit you want to test then, from the Tools menu choose Circuits > Set Circuit State. 

b. On the Set Circuit State dialog box, choose IS (in service), OOS, (out of service) or OOS-AINS 
(auto inservice) from the Target State drop-down menu.

c. If it is unchecked, check the Apply to drop ports check box.

d. Click Apply.

Stop. You have completed this procedure.
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NTP-B191 Create an E-Series EtherSwitch Circuit (Multicard or 
Single-Card Mode)

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If a high number of VLANs is already used by the network, complete the “DLP-B99 Determine 
Available VLANs” task on page 5-68 to verify that sufficient VLAN capacity is available (you will 
create a VLAN during each circuit creation task).

Step 3 Verify that the circuit source and destination Ethernet cards are provisioned for the mode of the circuit 
you will create, either multicard or single-card. See the “DLP-B246 Provision E-Series Ethernet Card 
Mode” task on page 5-69.

Step 4 Provision and enable the Ethernet ports. See “DLP-B220 Provision E-Series Ethernet Ports” task on 
page 5-69.

Step 5 From the View menu choose Go to Network View. 

Step 6 Click the Circuits tab, then click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for an Ethernet multicard circuit are STS-1 and 
STS-3c. Valid circuit sizes for an Ethernet single-card circuit are STS-1, STS-3c, STS6c, and 
STS12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable.

• State—Choose IS (in service). Ethergroup circuits are always in service.

• Apply to drop ports—Uncheck this check box.

• Create cross-connects only (TL1-like)—Uncheck this check box; it does not apply to Ethernet 
circuits. 

Purpose This procedure creates a multicard or single-card EtherSwitch circuit. It 
does not apply to E-Series cards in port-mapped mode. To create a 
port-mapped mode circuit, see the NTP-B192 Create a Circuit for an 
E-Series Card in Port-Mapped Mode, page 5-55.

Tools/Equipment E-Series Ethernet cards must be installed at each end of the Ethernet 
circuit.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 8 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 9 Click Next.

Step 10 Provision the circuit source:

a. From the Node drop-down menu choose one of the EtherSwitch circuit endpoint nodes. Either end 
node can be the EtherSwitch circuit source.

b. From the Slot drop-down menu choose one of the following:

– If you are building a multicard EtherSwitch circuit, choose Ethergroup.

– If you are building a single-card EtherSwitch circuit, choose the Ethernet card where you 
enabled the single-card EtherSwitch.

Step 11 Click Next.

Step 12 Provision the circuit destination:

a. From the Node drop-down menu choose the second EtherSwitch circuit endpoint node.

b. From the Slot drop-down menu choose one of the following:

– If you are building a multicard EtherSwitch circuit, choose Ethergroup.

– If you are building a Single-card EtherSwitch circuit, choose the Ethernet card where you 
enabled the single-card EtherSwitch.

Step 13 Click Next.

Step 14 In the Circuit VLAN Selection area, click New VLAN. If the desired VLAN already exists, continue 
with Step 17.

Step 15 In the New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily-identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 and 
4093 that is not already assigned to an existing VLAN. Each ONS 15327 network supports a 
maximum of 509 user-provisionable VLANs.

Step 16 Click OK.

Step 17 In the Circuit VLAN Selection area, highlight the VLAN name and click the arrow button (>>) to move 
the available VLAN(s) to the Circuit VLANs column. 

Step 18 If you are building a single-card EtherSwitch circuit and want to disable spanning tree protection on this 
circuit, uncheck the Enable Spanning Tree check box and click OK on the Disabling Spanning Tree 
dialog box. The Enable Spanning Tree check box will remain checked or unchecked for the creation of 
the next single-card point-to-point Ethernet circuits.

Caution Disabling spanning tree protection increases the likelihood of logic loops on an Ethernet network.

Caution Turning off spanning tree on a circuit-by-circuit basis means that the ONS 15327 is no longer protecting 
the Ethernet circuit and that the circuit must be protected by another mechanism in the Ethernet network.
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Caution Multiple circuits with spanning tree protection enabled will incur blocking if the circuits traverse the 
same E-series card and use the same VLAN.

Note You can disable or enable spanning tree protection on a circuit-by-circuit basis only for single-card, 
point-to-point Ethernet circuits. Other E-series Ethernet configurations disable or enable spanning tree 
on a port-by-port basis.

Step 19 Click Next.

Step 20 Confirm that the following information about the circuit is correct:

• Circuit name

• Circuit type

• Circuit size

• ONS 15327 circuit nodes

Step 21 Click Finish.

Step 22 Complete the “DLP-B220 Provision E-Series Ethernet Ports” task on page 5-69. 

Step 23 Complete the “DLP-B221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 5-70.

Stop. You have completed this procedure.

NTP-B192 Create a Circuit for an E-Series Card in Port-Mapped 
Mode

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 Provision the Ethernet cards that will carry the circuit for port-mapped mode. See the “DLP-B246 
Provision E-Series Ethernet Card Mode” task on page 5-69.

Step 3 Provision and enable the Ethernet ports. See the “DLP-B220 Provision E-Series Ethernet Ports” task on 
page 5-69.

Step 4 From the View menu choose Go to Network View. 

Purpose This procedure creates an E-Series point-to-point SONET circuit with an 
E-Series card in port-mapped mode.

Tools/Equipment An E-Series Ethernet card must be installed at each end of the circuit and 
configured in port-mapped mode.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click the Circuits tab and click Create.

Step 6 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for an E-Series circuit in port-mapped mode are 
STS-1, STS-3c, STS6c, STS-9c, and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Select this checkbox if you want to apply the state chosen in the State field 
(IS or OOS-MT only) to the Ethernet circuit source and destination ports. You cannot apply 
OOS-AINS to E-Series Ethernet card ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays 
the ports where the circuit state could not be applied. If the check box is unchecked, CTC will not 
change the state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Uncheck this check box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Auto-ranged—Unavailable.

• Protected Drops—Leave the default unchanged (unchecked).

Step 7 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 8 Click Next.

Step 9 Provision the circuit source:

a. From the Node drop-down menu choose the circuit source node. Either end node can be the 
point-to-point circuit source.

b. From the Slot drop-down menu choose the slot containing the E-Series card that you will use for 
one end of the point-to-point circuit.
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c. From the Port drop-down menu choose a port.

Step 10 Click Next.

Step 11 Provision the circuit destination:

a. From the Node drop-down menu choose the circuit destination node.

b. From the Slot drop-down menu choose the slot containing the E-Series card that you will use for 
other end of the point-to-point circuit.

c. From the Port drop-down menu choose a port.

Step 12 Click Next. The Circuits window appears.

Step 13 Confirm that the following circuit information is correct:

• Circuit name

• Circuit type

• Circuit size

• ONS 15327 circuit nodes

Step 14 Click Finish.

Step 15 Complete the “NTP-B146 Test E-Series Circuits” procedure on page 5-72.

Stop. You have completed this procedure.

NTP-B142 Create an E-Series Shared Packet Ring Ethernet 
Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If a high number of VLANs is already used by the network, complete the “DLP-B99 Determine 
Available VLANs” task on page 5-68 to verify that sufficient VLAN capacity is available (you will 
create a VLAN during each circuit creation task).

Step 3 Verify that the Ethernet cards that will carry the circuit are provisioned for multi-card EtherSwitch 
Group. See the “DLP-B246 Provision E-Series Ethernet Card Mode” task on page 5-69.

Step 4 Provision and enable the Ethernet ports. See “DLP-B220 Provision E-Series Ethernet Ports” task on 
page 5-69.

Purpose This procedure creates a shared packet ring Ethernet circuit. It does not 
apply to E-Series cards in port-mapped mode.

Tools/Equipment E-Series Ethernet cards must be installed at both Ethernet circuit endpoint 
nodes.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 From the View menu choose Go to Network View. 

Step 6 Click the Circuits tab and click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid shared packet ring circuit sizes are STS-1 and STS-3c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose IS (in service). Ethergroup circuits are always in service.

• Apply to drop ports—Uncheck this check box; states cannot be applied to E-Series ports.

• Create cross-connects only (TL1-like)—Uncheck this check box; it does not apply to Ethernet 
circuits. 

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 8 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 9 Click Next.

Step 10 Provision the circuit source:

a. From the Node drop-down menu choose one of the shared packet ring circuit endpoint nodes. Either 
end node can be the shared packet ring circuit source.

b. From the Slot drop-down menu choose Ethergroup.

Step 11 Click Next.

Step 12 Provision the circuit destination:

a. From the Node drop-down menu choose the second shared packet ring circuit endpoint node.

b. From the Slot drop-down menu choose Ethergroup.

Step 13 Click Next.

Step 14 Review the VLANs listed in the Available VLANs area. If the VLAN you want to use appears, continue 
with Step 15. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

– VLAN Name—Assign an easily-identifiable name to your VLAN.

– VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15327 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.
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Step 15 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Note Moving the VLAN from Available VLANs to Circuit VLANs forces all the VLAN traffic to use 
the shared packet ring you are creating.

Step 16 Click Next.

Step 17 In the Circuit Routing Preferences area, uncheck the Route Automatically check box and click Next.

Step 18 In the Route Review and Edit area, click the source node, then click a span (green arrow) that is leading 
away from the source node. 

The span turns white.

Step 19 Click Add Span.

The span turns blue. CTC adds the span to the Included Spans list.

Step 20 Click the node at the end of the blue span.

Step 21 Click the green span attached to the node selected in Step 20. 

The span turns white.

Step 22 Click Add Span.

The span turns blue.

Step 23 Repeat Steps 19 through 22 for every node in the ring. 

Step 24 Verify that the new circuit is correctly configured. If the circuit information is not correct, click the Back 
button and repeat the procedure with the correct information. 

Note If the circuit is incorrect, you can also click Finish, delete the completed circuit, and begin the 
procedure again.

Step 25 Click Finish.

Step 26 Complete the “DLP-B220 Provision E-Series Ethernet Ports” task on page 5-69 for each node that 
carries the circuit.

Step 27 Complete the “DLP-B221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 5-70 
for each node that carries the circuit.

Step 28 Complete the “NTP-B146 Test E-Series Circuits” procedure on page 5-72.

Stop. You have completed this procedure.
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NTP-B143 Create an E-Series Hub and Spoke Ethernet 
Configuration

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at the hub node (common endpoint). If you 
are already logged in, continue with Step 2.

Step 2 Complete the “DLP-B99 Determine Available VLANs” task on page 5-68 to verify that sufficient VLAN 
capacity is available (you will create a VLAN during each circuit creation task).

Step 3 Display the node view. 

Step 4 Verify that the Ethernet card that will carry the hub and spoke circuit is provisioned for Single-card 
EtherSwitch Group. See the “DLP-B246 Provision E-Series Ethernet Card Mode” task on page 5-69.

Step 5 Provision and enable the Ethernet ports. See “DLP-B220 Provision E-Series Ethernet Ports” task on 
page 5-69.

Step 6 Log into the destination spoke node, and repeat Steps 3 and 4 for the destination Ethernet card. You only 
need to verify that the hub node is provisioned for single-card EtherSwitch once. 

Step 7 Click the Circuits tab and click Create.

Step 8 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for an Ethernet single-card circuit are STS-1, 
STS-3c, STS6c, and STS12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose IS (in service)

• Apply to drop ports—Uncheck this check box; states cannot be applied to E-Series ports. 

• Create cross-connects only (TL1-like)—uncheck this check box; it does not apply to Ethernet 
circuits.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

Purpose This procedure creates a hub and spoke Ethernet configuration, which is 
made up of multiple circuits that share a common endpoint. It does not 
apply to E-Series cards in port-mapped mode.

Tools/Equipment E-Series Ethernet cards must be installed at all Ethernet circuit endpoint 
nodes.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Protected Drops—Leave the default unchanged (unchecked).

Step 9 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 10 Click Next.

Step 11 Provision the circuit source:

a. From the Node drop-down menu choose the hub node.

b. From the Slot drop-down menu choose the Ethernet card where you enabled the single-card 
EtherSwitch.

Step 12 Click Next.

Step 13 Provision the circuit destination:

a. From the Node drop-down menu choose an EtherSwitch circuit endpoint node.

b. From the Slot drop-down menu choose the Ethernet card where you enabled the single-card 
EtherSwitch.

Step 14 Click Next.

Step 15 Review the VLANs listed in the Available VLANs area. If the VLAN you want to use appears, continue 
with Step 17. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

– VLAN Name—Assign an easily-identifiable name to your VLAN.

– VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15327 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.

Step 16 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Note Moving the VLAN from Available VLANs to Circuit VLANs forces all the VLAN traffic to use 
the shared packet ring you are creating.

Step 17 Click Next.

Step 18 Confirm that the following information about the hub and spoke circuit is correct:

• Circuit name

• Circuit type

• Circuit size

• VLAN names

• ONS 15327 circuit nodes

If the circuit information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Note You can also click Finish, delete the completed circuit, and start the procedure from the 
beginning.
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Step 19 Click Finish. 

Step 20 Complete the “DLP-B220 Provision E-Series Ethernet Ports” task on page 5-69. 

Step 21 Complete the “DLP-B221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 5-70.

Step 22 Complete the “NTP-B146 Test E-Series Circuits” procedure on page 5-72.

Step 23 To create additional circuits (“spokes”):

a. Complete the “DLP-B99 Determine Available VLANs” task on page 5-68 to verify that sufficient 
VLAN capacity is available for the circuit destination node.

b. Repeat Steps 3 through 22.

Stop. You have completed this procedure.

NTP-B144 Create an E-Series Single-Card EtherSwitch Manual 
Cross-Connect

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-B314 Assign a Name to a Port” task on page 5-16. If not, continue with Step 3.

Step 3 If a high number of VLANs is already used by the network, complete the “DLP-B99 Determine 
Available VLANs” task on page 5-68 to verify that sufficient VLAN capacity is available (you will 
create a VLAN during each circuit creation task).

Step 4 Verify that the Ethernet card that will carry the circuit is provisioned for Singlecard EtherSwitch. See 
the “DLP-B246 Provision E-Series Ethernet Card Mode” task on page 5-69.

Step 5 From the View menu choose Go to Network View.

Step 6 Click the Circuits tab and click Create.

Purpose This procedure creates Single-Card EtherSwitch cross-connects between 
E-Series Ethernet cards and OC-N cards connected to non-ONS 
equipment. 

Tools/Equipment E-Series Ethernet cards must be installed at the circuit source node.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the cross-connect. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the cross-connect.

• Type—Choose STS.

• Size—Choose the cross-connect size. For single-card EtherSwitch, the available sizes are STS-1, 
STS-3c, STS-6c, and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS— The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Uncheck this check box.

• Create cross-connects only (TL1-like)—Uncheck this check box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 8 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 9 Click Next.

Step 10 Provision the circuit source:

a. From the Node drop-down menu choose the cross-connect source node. 

b. From the Slot drop-down menu choose the Ethernet card where you enabled the single-card 
EtherSwitch.

Step 11 Click Next.

Step 12 Provision the circuit destination:

a. From the Node drop-down menu choose the cross-connect circuit source node selected in Step 8. 
(For Ethernet cross-connects, the source and destination nodes are the same.)

b. From the Slot drop-down menu choose the OC-N card that is connected to the non-ONS equipment.

c. Depending on the OC-N card, choose the port and/or STS from the Port and STS drop-down menus.

Step 13 Click Next.
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Step 14 Review the VLANs listed in the Available VLANs area. If the VLAN you want to use appears, continue 
with Step 15. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

– VLAN Name—Assign an easily-identifiable name to your VLAN.

– VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15327 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.

Step 15 Click the VLAN you want to use on the Available VLANs column, then click the arrow >> button to 
move the VLAN to the Circuit VLANs column. 

Step 16 Click Next. The Circuit Creation (Circuit Routing Preferences) dialog box opens.

Step 17 Confirm that the following information about the single-card EtherSwitch manual cross-connect is 
correct (in this task, “circuit” refers to the Ethernet cross-connect):

• Circuit name

• Circuit type

• Circuit size

• VLAN names

• ONS 15327 nodes

If the information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Step 18 Click Finish.

Step 19 Complete the “DLP-B220 Provision E-Series Ethernet Ports” task on page 5-69. 

Step 20 Complete the “DLP-B221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 5-70.

Stop. You have completed this procedure.
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NTP-B145 Create an E-Series Multicard EtherSwitch Manual 
Cross-Connect

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a circuit endpoint. If you are already 
logged in, continue with Step 2.

Step 2 Complete the “DLP-B99 Determine Available VLANs” task on page 5-68 to verify that sufficient VLAN 
capacity is available (you will create a VLAN during each circuit creation task).

Step 3 Verify that the Ethernet card that will carry the circuit is provisioned for Multicard EtherSwitch Group. 
See the “DLP-B246 Provision E-Series Ethernet Card Mode” task on page 5-69.

Step 4 Provision and enable the Ethernet ports. See “DLP-B220 Provision E-Series Ethernet Ports” task on 
page 5-69.

Step 5 From the View menu choose Go to Network View.

Step 6 Click the Circuits tab and click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the source cross-connect. The name can be alphanumeric and up to 48 
characters (including spaces). Circuit names should be 44 characters or less if you want the ability 
to create monitor circuits. If you leave the field blank, CTC assigns a default name to the source 
cross-connect.

• Type—Choose STS.

• Size—Choose the size of the circuit that will be carried by the cross-connect. For multicard 
EtherSwitch circuits, the available sizes are STS-1 and STS-3c.

• Bidirectional—Leave checked.

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

Purpose This procedure manually creates Multicard EtherSwitch cross-connects 
between E-Series Ethernet cards and OC-N cards connected to non-ONS 
equipment. 

Tools/Equipment E-Series Ethernet cards must be installed at the circuit source node.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Uncheck this check box.

• Create cross-connects only (TL1-like)—Uncheck this check box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 8 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 9 Click Next.

Step 10 Provision the cross-connect source:

a. From the Node drop-down menu choose the cross-connect source node.

b. From the Slot drop-down menu choose Ethergroup.

Step 11 Click Next.

Step 12 From the Node drop-down menu in the Destination area, choose the circuit source node selected in 
Step 10. For Ethernet cross-connects, the source and destination nodes are the same.

The Slot field is provisioned automatically for Ethergroup.

Step 13 Click Next.

Step 14 Review the VLANs listed in the Available VLANs area. If the VLAN you want to use appears, continue 
with Step 16. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

– VLAN Name—Assign an easily-identifiable name to your VLAN.

– VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15327 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.

Step 15 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Step 16 Click Next.

The Circuit Creation (Circuit Routing Preferences) dialog box opens.

Step 17 Verify the cross-connect information (in this step, “circuit” refers to the Ethernet cross-connect):

• Circuit name

• Circuit type

• Circuit size
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• VLANs

• ONS 15327 nodes

If the information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Step 18 Click Finish.

Step 19 Complete the “DLP-B220 Provision E-Series Ethernet Ports” task on page 5-69. 

Step 20 Complete the “DLP-B221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 5-70.

Step 21 From the View menu choose Go to Home View.

Step 22 Click the Circuits tab.

Step 23 Highlight the circuit and click Edit.

The Edit Circuit dialog box opens.

Step 24 Click Drops and click Create.

The Define New Drop dialog box opens.

Step 25 From the Slot menu choose the OC-N card that links the ONS 15327 to the non-ONS 15327 equipment.

Step 26 From the Port menu choose the appropriate port.

Step 27 From the STS menu choose the STS that matches the STS of the connecting non-ONS equipment.

Step 28 Click OK.

Step 29 Confirm the circuit information that displays in the Edit Circuit dialog box and click Close.

Step 30 Repeat Steps 2 through 29 at the second Ethernet manual cross-connect endpoint.

The first and second Ethernet manual cross-connects will be bridged by the OC-N STS.

Note The appropriate STS circuit must exist in the non-ONS equipment to connect the two Ethernet manual 
cross-connect endpoints.

Caution If a CARLOSS alarm repeatedly appears and clears on an Ethernet manual cross-connect, the two 
Ethernet circuits might have a circuit-size mismatch. For example, a circuit size of STS-3c was 
configured on the first ONS 15327 and circuit size of STS-1 was configured on the second ONS 15327. 
Refer to the Cisco ONS 15327 Troubleshooting Guide if the alarm persists.

Step 31 Complete the “NTP-B146 Test E-Series Circuits” task on page 5-72.

Stop. You have completed this procedure.
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DLP-B99 Determine Available VLANs

Step 1 At any CTC view, click the Circuits tab.

Step 2 Click any existing Ethernet circuit to highlight that row.

Step 3 Click Edit, then click the VLANs tab.

The Edit Circuit dialog displays the number of VLANs used by circuits and the total number of VLANs 
available for use. 

Step 4 Determine that number of available VLANs listed is sufficient for the number of E-series Ethernet 
circuits that you will create.

Caution Multiple E-series Ethernet circuits with spanning tree enabled will block each other if the circuits 
traverse the same E-series Ethernet card and use the same VLAN.

Step 5 Return to your originating procedure (NTP). 

Purpose This task verifies that the network has the capacity to support the additional 
new VLANs required for the creation E-Series circuits. It does not apply 
to E-Series cards in port-mapped mode.

Tools/Equipment E-Series Ethernet cards must be installed at each end of the Ethernet 
circuit.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

DLP-B60 Log into CTC, page 2-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-B246 Provision E-Series Ethernet Card Mode

Caution You cannot change the mode while the Ethernet card is carrying circuits. If you want change the card 
mode, delete any circuits that it carries first. See the “NTP-B152 Delete Circuits” procedure on 
page 8-15.

Step 1 In the network view, double-click the node containing the E-Series Ethernet card you want to provision, 
then double-click the Ethernet card.

Step 2 Click the Provisioning > Ether Card tabs.

Step 3 In the Card Mode area, choose one of the following: 

• For multicard EtherSwitch circuit groups, choose Multicard EtherSwitch Group. Click Apply. 

• For single-card EtherSwitch circuits, choose Single-card EtherSwitch. Click Apply.

• For port-mapped circuits, choose port-mapped. Click Apply.

Step 4 Multicard EtherSwitch circuits only: repeat Steps 2 and 3 for all other Ethernet cards in the node that 
will carry the multicard EtherSwitch circuits.

Step 5 Repeat Steps this task for other nodes as necessary. 

Step 6 Return to your originating procedure (NTP).

DLP-B220 Provision E-Series Ethernet Ports

Step 1 Display the node view.

Step 2 Double-click the Ethernet card that you want to provision.

Step 3 Click the Provisioning > Ether Port tabs.

Purpose This task provisions an E-Series Ethernet card for multicard EtherSwitch 
Group, single-card EtherSwitch, or port-mapped mode.

Tools/Equipment E-Series Ethernet cards must be installed.

Prerequisite Procedures DLP-B60 Log into CTC, page 2-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables ports for the E-Series card.

Tools/Equipment None

Prerequisite Procedures DLP-B60 Log into CTC, page 2-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Provisioning or higher
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Step 4 For each Ethernet port, provision the following parameters:

• Port Name—If you want to label the port, type a port name.

• Mode—Choose the appropriate mode for the Ethernet port: Valid choices for the E-Series card are 
Auto, 10 Half, 10 Full, 100 Half, or 100 Full. 

• Enabled—Check this check box to activate the corresponding Ethernet port.

• Priority—Choose a queuing priority for the port. Options range from 0 (Low) to 7 (High). Priority 
queuing (IEEE 802.1Q) reduces the impact of network congestion by mapping Ethernet traffic to 
different priority levels. Refer to the priority queuing information in the Cisco ONS 15327 Reference 
Manual. This parameter does not apply to an E-Series card in port-mapped mode.

• Stp Enabled—Check this check box to enable the spanning tree protocol (STP) on the port. This 
parameter does not apply to an E-Series card in port-mapped mode. Refer to the spanning tree 
information in the Cisco ONS 15327 Reference Manual.

Step 5 Click Apply.

Step 6 Repeat Steps 1 through 5 for all other cards in the VLAN or in port-mapped mode, the other card in a 
point-to-point circuit.

Step 7 The Ethernet ports are provisioned and ready to be configured for VLAN membership. See the 
“DLP-B221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 5-70 for 
instructions.

Step 8 Return to your originating procedure (NTP).

DLP-B221 Provision E-Series Ethernet Ports for VLAN Membership

Step 1 Display the node view.

Step 2 Double-click the E-Series card graphic to open the card.

Step 3 Click the Provisioning > Ether VLAN tabs.

Step 4 To put a port in a VLAN:

a. Click the port and choose either Tagged or Untag. Table 5-4 shows valid port settings.

Purpose This task provisions E-Series card ports for VLAN membership. It does not 
apply to E-Series cards in port-mapped mode.

Tools/Equipment None

Prerequisite Procedures DLP-B60 Log into CTC, page 2-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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b. If a port is a member of only one VLAN, choose Untag from the Port column in the VLAN’s row. 
Choose -- for all the other VLAN rows in that Port column. 

Note The VLAN with Untag selected can connect to the port, but other VLANs cannot access that 
port.

c. Choose Tagged at all VLAN rows that need to be trunked. Choose Untag VLAN rows that do not 
need to be trunked, for example, the default VLAN. 

Note Each Ethernet port must attach to at least one untagged VLAN. A trunk port connects 
multiple VLANs to an external device, such as a switch, which also supports trunking. A 
trunk port must have tagging (802.1Q) enabled for all the VLANs that connect to that 
external device. 

Step 5 After each port is in the appropriate VLAN, click Apply.

Note .If Tagged is chosen, the attached external Ethernet devices must recognize IEEE 802.1Q 
VLANs.

Step 6 Return to your originating procedure (NTP).

Table 5-4 VLAN Settings

Setting Description

-- A port marked with this symbol does not belong to the VLAN.

Untag The ONS 15327 will tag ingress frames and strip tags from egress frames.

Tagged The ONS 15327 will process ingress frames according to the VLAN ID; egress 
frames will not have their tags removed.
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NTP-B146 Test E-Series Circuits

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at the ONS 15327 source node. If you are 
already logged in, continue with Step 2.

Step 2 On the shelf graphic, double-click the circuit source card. 

Step 3 Click the Provisioning > Ether Port tabs.

Step 4 Verify the following settings:

• Mode— Auto, 10 Half, 10 Full, 100 Half, or 100 Full.

• Enabled—Checked.

• Priority—Set to the priority level indicated by the circuit or site plan. Priority does not apply to 
E-Series cards in port-mapped mode.

• Stp—Checked if Spanning Tree Protocol is enabled for the circuit. STP does not apply to E-Series 
cards in port-mapped mode.

Step 5 Click the Ether VLAN tab. If the E-Series cards is not in port-mapped mode, verify that the source port 
is on the same VLAN as the destination port.

Step 6 Repeat Steps 1 through 5 for the destination node. 

Step 7 At the destination node, connect the Ethernet test set to the destination port and configure the test set to 
send and receive the appropriate Ethernet traffic. 

Note At this point, you will not be able to send and receive Ethernet traffic.

Step 8 At the source node, connect an Ethernet test set to the source port and configure the test set to send and 
receive the appropriate Ethernet traffic.

Step 9 Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic 
between the nodes, repeat Steps 1 through 8 to make sure you configured the Ethernet ports and test set 
correctly.

Purpose This procedure tests circuits created on E-Series Ethernet cards 
provisioned for multicard EtherSwitch Group, single-card EtherSwitch or 
port-mapped mode.

Tools/Equipment Ethernet test set and appropriate fibers

Prerequisite Procedures This procedure assumes that you completed facility loopback tests to test 
the fibers and cables from the source and destination ONS 15327s to the 
fiber distribution panel or the DSX, and one of the following: 

NTP-B191 Create an E-Series EtherSwitch Circuit (Multicard or 
Single-Card Mode), page 5-53

NTP-B142 Create an E-Series Shared Packet Ring Ethernet Circuit, page 
5-57

NTP-B143 Create an E-Series Hub and Spoke Ethernet Configuration, 
page 5-60

Required/As Needed As needed

Onsite/Remote Onsite

Security Provisioning or higher
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Step 10 Perform the protection switch testing appropriate to your SONET topology:

• For path protection, see the “DLP-B94 Path Protection Switching Test” task on page 4-26

• For BLSRs see the “DLP-B91 BLSR Ring Switch Test” task on page 4-20.

Configure your test set according to local site practice. For information about configuring your test set, 
see your test set user guide.

Step 11 After the Ethernet test is complete, print the results or save them to a disk for future reference. For 
information about printing or saving test results see your test set user guide.

Stop. You have completed this procedure.

NTP-B147 Create a G-Series Circuit

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the circuit. If you are already logged in, continue with Step 2.

Step 2 From the View menu choose Go to Network View. 

Step 3 Click the Circuits tab and click Create.

Step 4 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for a G-Series circuit are STS-1, STS-3c, STS6c, 
STS-9c, STS-12c, STS-24c, and STS-48c. 

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS— The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

Purpose This procedure creates a G-Series circuit.

Tools/Equipment A G-Series Ethernet card must be installed at each end of the circuit.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
(IS or OOS-MT only) to the Ethernet circuit source and destination ports. You cannot apply 
OOS-AINS to G-Series Ethernet card ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays 
the ports where the circuit state could not be applied. If the check box is unchecked, CTC will not 
change the state of the source and destination ports.

Note LOS alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Uncheck this check box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Auto-ranged—Unavailable.

• Protected Drops—Leave the default unchanged (unchecked).

Step 5 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 6 Click Next.

Step 7 Provision the circuit source:

a. From the Node drop-down menu choose the circuit source node. Either end node can be the 
point-to-point circuit source.

b. From the Slot drop-down menu choose the slot containing the G-Series card that you will use for 
one end of the point-to-point circuit.

c. From the Port drop-down menu choose a port.

Step 8 Click Next.

Step 9 Provision the circuit destination:

a. From the Node drop-down menu choose the circuit destination node.

b. From the Slot drop-down menu choose the slot containing the G-Series card that you will use for 
other end of the point-to-point circuit.

c. From the Port drop-down menu choose a port.

Step 10 Click Next. The Circuits window appears.

Step 11 Confirm that the following circuit information is correct:

• Circuit name

• Circuit type

• Circuit size

• ONS 15327 circuit nodes

Step 12 Click Finish.
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Note To change the capacity of a G-Series circuit, you must delete the original circuit and reprovision 
a new larger circuit.

Step 13 Complete the “NTP-B149 Test G-Series Circuits” procedure on page 5-78.

Stop. You have completed this procedure.

NTP-B148 Create a Manual Cross-Connect for a G-Series or an 
E-Series in Port-Mapped Mode 

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node where you will create the 
cross-connect. If you are already logged in, continue with Step 2.

Step 2 If you are provisioning an E-Series card, verify that the Ethernet card that will carry the circuit is 
provisioned for port-mapped mode. See the “DLP-B246 Provision E-Series Ethernet Card Mode” task 
on page 5-69.

Step 3 Click the Circuits tab and click Create.

Step 4 In the Create Circuits dialog box, complete the following fields:

• Name—Assign a name to the source cross-connect. The name can be alphanumeric and up to 48 
characters (including spaces). Circuit names should be 44 characters or less if you want the ability 
to create monitor circuits. If you leave the field blank, CTC assigns a default name to the source 
cross-connect.

• Type—Choose STS.

• Size—Choose the size of the circuit that will be carried by the cross-connect. Valid sizes for a 
G-Series circuit are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, and STS-48c. For an 
E-Series in port-mapped mode, valid sizes are STS-1, STS-3c, STS-6c, and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

Purpose This procedure creates a manual cross-connect between a G-Series 
Ethernet card or an E-Series card in port-mapped mode and an OC-N card 
connected to non-ONS equipment. 

Tools/Equipment A G-Series or E-Series card must be installed at the circuit source node.

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Auto-ranged—Unavailable.

• State—Choose a service state to apply to the circuit after it is created:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and permits loopbacks on the circuit. Use OOS-MT 
for circuit testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-B230 Change a Circuit State” task on 
page 8-8.

• Apply to drop ports—Uncheck this check box.

• Create cross-connects only (TL1-like)—Uncheck this check box

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 5 If the circuit will be routed on a path protection, complete the “DLP-B218 Provision Path Protection 
Selectors During Circuit Creation” task on page 5-27.

Step 6 Click Next.

Step 7 Provision the circuit source:

a. From the Node drop-down menu choose the circuit source node. 

b. From the Slot drop-down menu choose the Ethernet card that will be the cross-connect source.

c. From the Port drop-down menu choose the cross-connect source port.

Step 8 Click Next.

Step 9 Provision the circuit destination:

a. From the Node drop-down menu choose the same node selected as the circuit source. For Ethernet 
cross-connects, the source and destination nodes are the same.

b. From the Slot drop-down menu choose the OC-N card that connects to the non-ONS equipment.

c. Depending on the OC-N card, choose the port and STS from the Port and STS drop-down menus.

Step 10 Click Next.

Step 11 Verify the cross-connect information (in this step, “circuit” refers to the cross-connect): 

• Circuit name

• Circuit type

• Circuit size

• ONS 15327 circuit nodes

If the information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Step 12 Click Finish.
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Step 13 Complete the “NTP-B149 Test G-Series Circuits” procedure on page 5-78 for the G-Series circuit, or 
complete the “NTP-B146 Test E-Series Circuits” procedure on page 5-72 for the E-Series in 
port-mapped mode circuit.

Stop. You have completed this procedure.

DLP-B222 Provision G-Series Ethernet Ports

Step 1 In the node view, double-click the G-Series card graphic to open the card.

Step 2 Click the Provisioning > Port tabs.

Step 3 For each G-Series port, provision the following parameters:

• Port Name—If you want to label the port, type the port name.

• State—Choose IS to put the port in service.

• Flow Control Neg—Click this check box to enable flow control negotiation on the port. If you do 
not want to enable flow control, uncheck the box.

Note To activate flow control, the Ethernet device attached to the G-Series card must be set to 
auto-negotiation. If flow control is enabled but the negotiation status indicates no flow control, 
check the auto-negotiation settings on the attached Ethernet device.

• Max Size—To permit the acceptance of jumbo size Ethernet frames, choose Jumbo. If you do not 
want to permit jumbo size Ethernet frames, choose 1548.

Note The maximum frame size of 1548 bytes enables the port to accept valid Ethernet frames that use 
protocols, such as Inter-Switch Link (ISL). ISL adds 30 bytes of overhead and may cause the 
frame size to exceed the traditional 1518 byte maximum.

Step 4 Click Apply.

Step 5 Refresh the Ethernet statistics:

a. Click the Performance > Statistics tabs.

b. Click the Refresh button.

Note Reprovisioning an Ethernet port on the G-Series card does not reset the Ethernet statistics for 
that port. 

Purpose This task provisions G-Series Ethernet ports.

Tools/Equipment None

Prerequisite Procedures DLP-B60 Log into CTC, page 2-23

Required/As Needed Required to enable Ethernet traffic on the G-Series

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Return to your originating procedure (NTP). 

NTP-B149 Test G-Series Circuits

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at the ONS 15327 source node. If you are 
already logged in, continue with Step 2.

Step 2 Change the circuit and circuit ports to an OOS-MT service state:

a. Click the Circuits tab.

b. Click the circuit you want to test.

c. From the Tools menu choose Circuits > Change Circuit State.

d. On the Change Circuit State dialog box, choose OOS_MT from the Target Circuit State drop-down 
menu. 

e. Check the Apply to circuit drops check box.

f. Click OK.

Step 3 On the shelf graphic, double-click the circuit source card. 

Step 4 Click the Provisioning > Port tabs.

Step 5 Verify the following settings:

• State—OOS_MT

• Flow Control Neg—Checked or unchecked as indicated by the circuit or site plan

• Max Size—Check or unchecked as indicated by the circuit or site plan

• Media Type— SX or LX

Step 6 Repeat Steps 1 through 5 for the destination node. 

Step 7 At the destination node connect the Ethernet test to the destination port and configure the test set to send 
and receive the appropriate Ethernet traffic. 

Note At this point, you will not be able to send and receive Ethernet traffic.

Purpose This procedure tests circuits created on G-Series Ethernet cards.

Tools/Equipment Ethernet test set and appropriate fibers

Prerequisite Procedures This procedure assumes that you completed facility loopback tests to test 
the fibers and cables from the source and destination ONS 15327s to the 
fiber distribution panel or the DSX. 

NTP-B147 Create a G-Series Circuit, page 5-73 or

NTP-B148 Create a Manual Cross-Connect for a G-Series or an E-Series 
in Port-Mapped Mode, page 5-75

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 8 At the source node connect an Ethernet test set to the source port and configure the test set to send and 
receive the appropriate Ethernet traffic.

Step 9 Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic 
between the nodes, repeat Steps 1 through 6 to make sure you configured the Ethernet ports and test set 
correctly.

Step 10 Perform the protection switch that is appropriate to the SONET topology:

• For path protection, see the “DLP-B94 Path Protection Switching Test” task on page 4-26.

• For BLSRs see the “DLP-B91 BLSR Ring Switch Test” task on page 4-20.

Configure your test set according to local site practice. For information about configuring your test set, 
see your test set user guide.

Step 11 Change the circuit and circuit ports to the IS service state:

a. Click the Circuits tab.

b. Choose the circuit you want to test. 

c. From the Tools menu choose Circuits > Change Circuit State.

d. In the Change Circuit State dialog box, choose IS from the Target Circuit State drop-down menu. 

e. Check the Apply to circuit drops check box.

f. Click OK.

Step 12 After the circuit test is complete, print the results or save them to a disk for future reference. For 
information about printing or saving test results see your test set user guide. 

Stop. You have completed this procedure.

NTP-B194 Create Overhead Circuits

Step 1 Complete the “DLP-B60 Log into CTC” task on page 2-23 at a node on the network where you will 
create the overhead circuit. If you are already logged in, continue with Step 2.

Step 2 From the View menu choose Go to Network View.

Step 3 As needed, complete the “DLP-B313 Create a DCC Tunnel” task on page 5-80.

Step 4 As needed, complete the “DLP-B212 Create a User Data Channel” task on page 5-81.

Stop. You have completed this procedure.

Purpose This procedure creates overhead circuits on an ONS 15327 network. 
Overhead circuits include DCC tunnels, orderwire, and user data channels.

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-B313 Create a DCC Tunnel

Note Each ONS 15327 can have up to 32 DCC tunnel connections. Terminated Section DCCs used by the 
ONS 15327 cannot be used as DCC tunnel endpoints, and a Section DCC that is used as an DCC tunnel 
endpoint cannot be terminated. All DCC tunnel connections are bidirectional. 

Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Circuit Creation dialog box (Figure 5-13), provision the DCC tunnel:

• Name—Type the tunnel name.

• Type—Choose one:

– DCC Tunnel-D1-D3—Allows you to choose either the Section DCC (D1-D3) or a Line DCC 
(D4-D6, D7-D9, or D10-D12) as the source or destination endpoints.

– DCC Tunnel-D4-D12—Provisions the full Line DCC as a tunnel.

• Source Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, select the source port.

• Channel—Displayed if you chose DCC Tunnel-D1-D3 as the tunnel type. Choose one of the 
following:

– DCC1 (D1-D3)—Section DCC

– DCC2 (D4-D6)—Line DCC 1

– DCC3 (D7-D9)—Line DCC 2

– DCC4 (D10-D12)—Line DCC 3

DCC options are not displayed if they are used by the ONS 15327 (DCC1) or other tunnels.

Purpose This task creates a DCC tunnel to transport traffic from third-party SONET 
equipment across ONS 15327 networks. Tunnels can be created on the 
Section DCC channel (D1-D3) (if not used by the ONS 15327 as a 
terminated DCC), or any Line DCC channel (D4-D6, D7-D9, or D10-D12).

Tools/Equipment None

Prerequisite Procedures NTP-B127 Verify Network Turn Up, page 5-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 5-13 Provisioning a DCC Tunnel

Step 4 Click OK.

Step 5 Put the ports that are hosting the DCC tunnel in service. See the “DLP-B214 Change the Service State 
for a Port” task on page 4-6 for instructions.

Step 6 Return to your originating procedure (NTP).

DLP-B212 Create a User Data Channel 

Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Circuit Creation dialog box, complete the following fields:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down menu. 

Step 4 In the Endpoints area, choose the source and destination nodes and the source and destination optical 
ports and slots from the drop-down menus. 

Step 5 Click Finish.

Step 6 Return to your originating procedure (NTP). 

Purpose This task creates a user data channel (UDC) on the ONS 15327. A UDC 
circuit allows you to create a dedicated data channel between nodes. 

Tools/Equipment None

Prerequisite Procedures NTP-B24 Verify Card Installation, page 3-2

DLP-B60 Log into CTC, page 2-23

Required/As Needed As needed.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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